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1. iR

deaR &2 — M. RIEM R AR (R , ERVTH BT &R a8
245347 (Data Envelopment Analysis) & - [145 78

e FIEAR RERAFAAE I U, 2% BhAE R B A P 68 deaR.
WRIRRE—4 RN E, THEBEAY, s 71,

A deaR AT ELAEE RN 7 & . LB BUN. FAMEIR AL 7B 1)
S, AL, FRATHGRAE AT BE W% 0 deaR (9= WA L. FRATHHEARE R @t
MHESE , ZEBThR ) deaR HAT AL Hh N — LB A8 4 [T AR Hh A 48 B 45 4 25 1R ABE R A
RFME, U0 : stochastic DEA, network DEA, Malmquistindex (other decompositions

and bootstrapping) , f{E LLACR TR input/output 45 5 11 @ 4%

2. F#EIF%% R F RStudio

ZEH deaR, B JeIATTEE T #JF %% R M RStudio #fTF .

2.1. &% R B

AR B, FRATFE EAI1E R-project HE J7Wuk: http://www.r-project.org  (Z L& 1)

1: R-project M3k

R R The R Project for Statistical - X | =

[CIEH) @ & https:/fwww.r-project.org e @ Y

Q The R Project for Statistical Computing

Getting Started

[Home]

R is a free software environment for statistical computing and graphics. It compiles and runs on a wide
Download variety of UNIX platforms, Windows and MacOS. To download R, please choose your preferred CRAN
CRAN mirror.

If you have questions about R like how to download and install the software, or what the license terms
R Project are, please read our answers to frequently asked guestions before you send an email_
About R
Logo News

Contributors
What's New?
Reporting Bugs

« The R Foundation Conference Committee has released a call for proposals to host useR! 2020 in
North America.

Conferences = You can now support the R Foundation with a renewable subscription as a supporting member
Search

Get Involved: Mailing Lists « R version 3.5.1 (Feather Spray) has been released on 2018-07-02.

Developer Pages « The R Foundation has been awarded the Personality/Organization of the year 2018 award by the
R Blog professional association of German market and social researchers.

TE R B, B CRAN HE, RFEIERT(IMMIERIER "REuER"

(mirror site) ,

R, RIEFRERT BV ERFIEREIAER (ZWE 2) .

!Manual of introduction to R: https://cran.r-project.org/doc/manuals/r-release/R-intro.pdf
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2: RMIAFRRA

The Comprehensive R Archive Network

Download and Install R

Precompiled binary distributions of the base system and contributed packages, Windows and Mac users most likely want one of
these versions of R:

* Download R for Linux
» Download R for (Mac) O5 X
* Download R for Windows

R is part of many Linux distributions, you should check with your Linux package management system in addition to the link
above.

a) f£ Windows E&ZZE R

s Download R for Windows §&#%, FAMEFIFUTERFREINGI, SASRE install R
for the first time (ZD1E& 3)

3: Windows it R

R for Windows

Subdirectories:

base Binaries for base distribution. This 1s what you want{p install R for the ﬁlst time.

contiib Binaries of contributed CRAN packages (for R >= 213" t8es). There is also information on third
S— party software available for CRAN Windows services and coﬂespondmg environment and make variables.

old contrib Binaries of contributed CRAN packages for outdated versions of R (for R < 2.13.x; managed by Uwe Ligges).

Rtools Tools to build R and R packages. This is what you want to build your own packages on Windows, or to build R itself.

Please do not submit binaries to CRAN. Package developers might want to contact Uwe Ligges directly in case of questions / suggestions related to Windows binaries

You may also want to read the R FAQ and R for Windows FAQ.

Note: CRAN does some checks on these binaries for viruses, but cannot give guarantees. Use the normal prec with downl

Ancd hi

exec

T3k, =i Download R 3.5.1 for Windows FH{RFZENHE (2WE4) .

4. T# Windows JilxH R

R-3.5.1 for Windows (32/64 bit)

(mm R 3.5.1 for Windows [§2 megabytes, 32/64 bit)

Installa 10ns
MNew features in this version

If you want to double-check that the package you have downloaded matches the package distributed by CRAN. you can compare the md3sum of the .exe to the
fingerprint on the master server You will need a version of md3sum for windows: both graphical and command line versions are available.

Frequently asked questions

* Does R run under myv version of Windows?
» How do I update packages in my previous version of R7
* Should I run 32-bit or 64-bit R?

Please see the R FAQ for general information about R and the R Windows FAQ for Windows-specific information.

WE TEHAISG LSS R (UL %R
b) £ Mac EZZER

mth Download R for (Mac) 0S X, ¥JFFAN FEIFAIMNIE, RER R-3.5.1.pkg THZE
=i (2RES) .
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K 5: Mac ki R

R for Mac OS X

This directory contains binaries for a base distribution and packages to run on Mac OS X (release 10.6 and above). Mac OS 8.6 to 9.2 (and Mac OS X 10.1) are no
longer supported but you can find the last supported release of R for these systems (which 1s R 1.7.1) here. Releases for old Mac OS X systems (through Maec OS X
10.5) and PowerPC Macs can be found in the old directory.

Note: CRAN does not have Mac OS X systems and cannot check these binaries for viruses. Although we take precautions when assembling binaries, please use the
normal precautions with downloaded executables.

As 0f 2016/03/01 package binaries for R versions older than 2.12.0 are only available from the CRAN archive so users of such versions should adjust the CRAN
mirror setting accordingly.

R 3.5.1 "Feather Spray" released on 2018/07/05

Important: since R 3.4.0 release we are now providing binaries for OS X 10.11 (El Capitan) and higher using non-Apple toolkit to provide support for OpenMP
and C++17 standard features. To compile packages you may have to download tools from the tools directory and read the corresponding note below.

Please check the MD3 checksum of the downloaded image to ensure that it has not been tampered with or corrupted during the mirroring process. For example type
md5 R-3.5.1.pkg

in the Terminal application to print the MD5 checksum for the R-3.5.1 pkg image. On Mac OS X 10.7 and later you can also validate the signature using
pkgutil --check-signature R-3.5.1.pkg

Lastest release:

R 3.5.1 binary for OS X 10.11 (El Capitan) and higher. signed package. Contains R 3.5.1 framework.
= e e i R.app GUI 1.70 in 64-bit for Intel Macs. Tcl/'Tk 8.6.6 X11 libraries and Texinfo 5.2. The latter two
(ca. TAMB) D b= components are optional and can be ommitted when choosing "custom install”, they are only needed 1f

vou want to use the celtk R package or build package documentation from sources.

Note: the use of X11 (including tclck) requires XQuartz to be installed since it 1s no longer part of
08 X Always re-mnstall XQuartz when upgrading your macOS to a new major version.

Important: this release uses Clang 6.0.0 and GNU Fortran 6.1. neither of which is supplied by Apple.
If you wish to compile R packages from sources. you will need to download and install those tools -
see the tools directory.

¥IFF R-3.5.1.pkg FHZARIHEAZ % R,
2.2. & %& RStudio
R BT ZERINE, BAN@ITLATHEE FE RStudio (BIE6) .

https://www.rstudio.com/products/rstudio/download/#download

K 6: %K RStudio

RStudio Desktop 1.1.463 — Relsase Notes
RStudio requires R 3.0.1+. If you don't already have R, download it here.

Linux users may need to import RStudio's public code-signing key prior to installation, depending on the operating system's security
policy.

Installers for Supported Platforms

Installers Size Date MD5

858MB  2018-10-2¢ 58b3d796dBcfIGEbASENCE2E4Gabadde
745MB  2018-1029 a79032badd7daaaBEaBda01948278d94
893MB 2018-10-29 Ba6755fa%faeZbafce289df3358aa£63
974MB 20181029 bc50débd34926clcc3ae4a209d67d649
65MB 20181029 cfdE59db1B619ccT78d1592fefaalc753

88.1MB Z2018-10-28 742f0badé0dfeaa3281576el4adE699e

90.6M 2018-10-29 <7303067a0ca%5deca7e427b856552d1

TEETHATSUSRT, IR ERIBIR R REESEXY MATEI:
e RStudio 1.1.463 - Windows Vista/7/8/10

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)
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e RStudio 1.1.463 - Mac OS X 10.6+ (64-bit)
SeARAF AT PAT SO, ARG IR U BH 2223 RStudio,

3. RStudio A\J7]

ST RStudio AR RIFHIAZ T, —MERIL R, FA1HE Rstudio A R,
ik Rstudio bR | € , REhEAE,

ITIT RStudio J&i, FRATATLLE B 7 BR300 A 78

?nRawmﬁWﬁﬁ

File Edit Code View Plots Session Build Debug Profile Tools Help

= Environment History Connections -

L H

RStudio - g I

# Import Dataset = | & List ~
R version 3.4.2 (2017-09-28) -- "Short Summer"

Copyright (C) 2017 The R Foundation for Statistical Computing " Global Environment -
Platform: x86_64-wb4-mingw32/x64 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'Ticence()' for distribution details.

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
‘citation()' on how to cite R or R packages in publications.

] Plots Packa Help Vi
Type 'demo()' for some demos, 'help()' for on-line help, or © et i) SB sl ! —]
'help.start()' for an HTML browser interface to help. New Folder | @ Delete ] Rename ‘c:’}Mure -

Type 'q()' to quit R. A Hom

R Home
@ A Mame size Modified
I
] Files and folders in
I My documents
.

BRINKE K, Console (46 ALFIHIRAM. EFMENEREYAZ G, HIARGHR
IRFF CES7 ) o ARBEER BIINERIEPRS 2 ZEX BRATT LIS B R 81T AFES .
BLLE Console FPATIR A IFIR1GEE R, % Enter B,

3.1. WA B A

e G TAEER 2R, FONEX B840 E M 298N 5 MPATH . B, 3R
A58 5 A8 FH A (seripts) BUAE 2 30F . KBS RN “.R” &

BRI A, FRATEEE File > New File > R Script

WIE, B EJRIARNR, £ TR Console (3EH]) EiR. BOAKE T, ZAH
Widr %N “Untitled1” (1L 8)

FERIA T, AT URAT R S 152 . IXEIRL LIz —iasqr, FATE e LhEd ke
Sl (EGE ) 4R RBATA A I ERRAE. BITHRAER D Frun,

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)
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Kl 8: A
6’

RStudio -
File Edit Code View Plots Session Build Debug Profile Tools Help
@ | Untitled1 [ Environment History Connections -
Source on Save A S = Run | *% Source ~ ' | * Import Dataset ~ ¥ List =
1| & Global Environment =
Files Plots Packages Help Viewer i
<}_ New Folder @  Delete | Rename {}Mure'
/l\ Home
A Name Size Modified
1:1 (Top Level) 5 R Script 5 _
— _r ] Files and folders in
You are welcome to redistribute it under certain conditions. ~ - My documents
Type 'license()' or 'licence()' for distribution details. .
R is a collaborative project with many contributors. -

Type 'contributors()' for more information and
‘citation()"' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start(Q' for an HTML browser interface to help.
Type 'g()' to quit R.

>

4. J{ATFE RStudio HEIEANFEHINE (project)

— H JA 3l RStudio, FATHLN 1Z K B T.4E H 3% (working directory) , F-11A R F1 RStudio
R . ARSI ATERE 2. (B2, BADNN, BIFIIERZTE RStudio HAIE—
i H (project) , FALEFTA S (Bl BIASE) DU HRHRE B RNIZINH « X
FE, TUHTBATAE M TEMRBEEEHFP . @ X oy, AT LR 5 4th A3
FOUH, BOBIE ZHIREG R 5 — SRS .

HERIR:

NN —ANES/ TR —AIE (Flin, NERECE/
30 .

NTIEHMEHIH, BATERAEDH TGS, 4R, X
AR 73 S QI A R 1 H 3K

4.1. RIEINH

BEALE RStudio FEIETH, FATIESE File > New project... PR)5, W LLE R4 KT R
I 2
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K9: gl (1) TiH

New Project

Create Project

1 : New Directory
Start a project in a brand new working directory

Existing Directory

= Ri Associate a project with an existing working director

F i Version Control
Checkout a project from a version control repository

Cancel

BAEH HZPREBIEH, B New Directory %4, SRJFIEFFIUH KM ., FEIRATHI =51
H1, &R New Project. TR, XfFr8IdMHR (BOCFR) #ATand, e
WHM M. fJa, s Create Project. LA LISFESERNG, FRATTHEAE B SCRS A4k 2
HOVERI S “folder_name.Rproj”

BEIA Bhe@miH, W Existing Directory ¥%#l, A5 midi Browse... EHE H %
O, e R Create Project B2 .
4.2. F;THWH

BATHOH, TENGWH “.Rproj” ¥ RAN M. HATHA] LLELIEFE RStudio ¢
B F [ File > Open Project... AT L THEEAE .

W PC S BATAEDT H i AR ORAF (AT SRR i AA R TUE 1 H SR

4.3. #h7efE 5
LAR 2 P43 A48 RStudio I H IR BEB0RE, 55 030 B4 1 Wl BT H (AT R N 2

e https://www.r-bloggers.com/managing-projects-using-rstudio/

e https://www.ssc.wisc.edu/sscc/pubs/RFR/RFR Projects.html#projects

4.4. W{AIEIETHH
PR 1. J33)) RStudio
IR 2. ¥EFE File > New Project
IR 3: 1%&FE New Directory

NG
W

. Project Type (WiHZEA) L+ New Project

N
(@]

: Directory name (Hx%FK) : Paper_1

. Create project as subdirectory of (Ei2INBNFHEHZR) : 5 Browse ik
LIHESZ'{L-F;EHIJE%’[I:) flan, &R "R=m|T X4k,

7: g5 Create Project

m\%ﬁ
38
Ch

N
i
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R K "Paper_1" BHREBEREXMAXRP, ZXHXREESLUTHENHE (&
WE 10) :

* Paper_1 (Z£8Y: R Project)

» _Rhistory (Z£EU: RHISTORY file)

10: WiH “Paper_1”
0

ers/\ - oIEN

File Edit Code View Plots Session Build Debug Profile Tooks Help

Q| Untitied1 ] Environment  History Connections =
Source on Save R - * Run N Source = i { “* Import Dataset = .'/ List -
1 Tk Giobal Environment ~
Plots Packages Help Viewer i T
G NewFolder © Delete = Rename 4gF More =
C ers © Vicente = Desktop = Paper_1
A Name
R Saipt 2 L.

Console </Vicente/Deskiop =™ T [o]:} Nov 1, 2018, 8:19 Al
You are welcome to redistribute it under certain conditions. = A8k oo 1 2N 20

Type ‘license()' or 'licence()' for distribution details.

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
‘citation(D' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

BERR:

W B T ESIE B TR ERF TP, RAJLL:
W aY E&A ".Roroj" BIS4
&
BT File > Open Project 1561RINE

FENERIETESI A,

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)



Data Envelopment Analysis with deaR

5. ZEEANE deaR
FJFF RStudio BETNE “Paper_1”

1%63% File > New File > R script

5.1. Z3E deaR

B % deaR, FWAEMA TN LI T 454
install.packages(“deaR”)

IR, ML e IFIZIES (B 1D .

IS4 T @ LRI Packages 528, DUHG & Bk ITE Cac e InTI% . ILTE,

deaR BAF RN IZAL AN H A

BEIRR:

AR T LHE deaR —REIAT. b5 AT LU B

WA 3RAF deaR IIBBTHRUA .

11: %% deaR
e

C:/Users/Vicente/Desktop/Paper_1 - RStudio - g -_
File Edit Code View Plots Session Build Debug Profile Tools Help
@ | Untitled1* - Environment History Connections -
| SourceonSave | Q- ik, 4 Source ~ # [ | 2 Import Dataset & List =
1 dnstall.packages ("dear") "} Global Environment =
pen
Files Plots Help  Viewer P |
O nstan | @ pazte | Wl Packrat
Name Description Version
— e = =
csvy Import and Export CSV Data with a YAML  0.3.0
1:24 (Top Level) = R Script = Metadata Header
— curl A Modern and Flexible Web ClientforR 32
Console C:/Users/Vicente/Desktop/Paper_1/ p— - s 2
- - = - — data.table Extension of ‘data.frame’ 1.116
You are welcome to redistribute it under certain conditions. A =7 R Dabaa i 100
Type 'Ticense()' or 'licence()' for distribution details. atabaseiriterace o
dbplyr A 'dplyr* Back End for Databases 1.2.2
R is a collaborative project with many contributors. deaR Conventional and Fuzzy Data 10
Type 'contributors(Q' for more information and Envelopment Analysis
Vot B ' B £ . .
citation()"' on how to cite R or R packages in publications. TS Debug R Packages )
Type 'demo()' for some demos, 'help()' for on-Tline help, or DEoptimR Differential Evolution Optimization in 1.0-8
‘help.start()' for an HTML browser interface to help. Pure R
Type 'g()' to quit R. desc Manipulate DESCRIPTION Files 120
devtools Tools to Make Developing R Packages 11386

>

Easier

5.2. JN#, deaR

242 | deaR BCHABAEAT R BAF )G, ESER E AT ndc e ¥ (2 WK

12) . Hk, FRAEBASALLFHEL

library(“deaR”)

XA R L P R PATIZIES .
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BERER:
AN TAELIEE L AINE, deaR BAEAL,

12: fn#k deaR
[E]

File Edit Code View Plots Session Build Debug Profile Tools Help

C:/Users/Vicente/Desktop/Paper_1 - RStudio - a n_

9] untitled1* =" Environment History Connections =
| [(JsourceonsSave | Q - > S 2 [ | £2 Import Dataset = | & e
install.packages("deaR") "} Global Environment =

1
2
3 library("deaR")
4

Files I’Inb Help | Viewer —_
O Install @ Update | [l Packrat

Name Description Version
s =T == ~
csvy Import and Export CSV Data with a YAML  0.3.0
41 Top Level) = R Seript = Metadata Header
= curl A Modern and Flexible Web ClientforR 3.2
Console C:/Users/Vicente/Desktop/Pape = = < f4
— = data.table Extension of ‘data.frame 1116
The following objects are masked from ‘package:stats’: et ROEabE a0 0y
dhplyvr A dplyr’ Back End for Databases 122

filter, lag Conventional and Fuzzy Data 1.0

. . Envelopment Analysis
The following objects are masked from ‘package:base’:

debugme Debug R Packages 110
intersect, setdiff, setequal, union DEoptimR Differential Evolution Optimization in 1.0-8
Pure R
warning message: desc Manipulate DESCRIPTION Files 120
Eackage ‘dplyr’ was built under R version 3.4.4 devtools Tools to Make Developing R Packages 1136
= Easier .

6. IRAFIIA IR TAE=1E
BRAFIIA, 1EF% File > Save as...

WAE, FATa L (e session_1) JE .5 Save TRAF . BRINRE T, AR H
PRAFAER N “Paper_17 WITH SCAFEJerd, X WIERLE TAEH A IHE 19— AMEF.

THEIER, B R SCfF CEIHIAS) B4 FR 2 “session 1.R” TiANJ& “Untitled1” (= LIE
13) o ZXHEERIEE T Paper 1 Wi H KA1 £,

e AR DU E Bl as o BB R EACAERATT AT DAL [F] — AN S
PE R — 4352

BERR:
REIAS S A (1) 4 R L RE S LA T 7T P9 258
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13: {RAFIIA
e

File Edit Code View Plots Session Build Debug Profile Tools Help

C:/Users/Vicente/Desktop/Paper_1 - RStudio - g n_

"  Environment History Connections )

Source on Save A S - *Run | "% Source ~ g “* Import Dataset = ' List =
install.packages("dear™) ik Giobal Enmvironment ~

1
2
3 Tlibrary("deaR")
4
5

Plnts Packages Help Viewer —
G New Folder | ©  Delete = Rename | g More ~

C:  Users » Vicente > Desktop * Paper_1
4 Name Size Modified
(Top Level) = R Saipt 3 t.

, . — “ | .Rhistory 168 Nov 1,2018,11:05/
Console Users te/Desktop/Paj —

. . . . s £ p, 1.Rproj 18B Nov 1, 2018, 11:
You are welcome to redistribute it under certain conditions. g 2L P R o2 23
Type 'license()" or 'licence()' for distribution details. 47B Nov 1,2018,11:26 /
R is a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.
Type 'demo()' for some demos, 'help()' for on-Tine help, or
'help.start()" for an HTML browser interface to help.
Type 'q()' to quit R.

>

WNRAEE XL FITI B REE Rstudio, 1H1%FE File > Close project

WNERABEER XA XL BF0 Rstudio, 1H1%EHE File > Quit Session

WE, BRAIRAE“session_1.R”, <IN H “Paper_1"3+iE H RStudio.

7. f#H deaR 1T H IR 4501 (Data Envelopment Analysis)
B IFIUE “Paper_17. AL, AT A “Paper_1.Rproj” , 17T RStudio F1i% i
H. 1HER, WAl LLE$TIF RStudio, SR J518IL File > Open Project 37 FF#8 € T H -

ok, AR —ASHIIEIA (File > New File > R Script) o {EIXANFHIHIAS, 3K
I AL N $84 LLIN#K deaR:

library(“deaR”)
($27: B Run %4510 - #ren $UATHE S

fERHEPRAER”RY (K 14) , BATTLEZMEH deaR HUATAEM DEA (B4
8T, LAURTERR DEA) BT,

10
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Data Envelopment Analysis with deaR dR

14: deaR K{#E L%

IR First steps:

Step 1

Step 2 | Read malmquist | I Read data | I Read Fuzzy data |
| J
!

Step 3 | Select DEA model |

7.1 B EEIAR

B DR RANBNREM TIAT DEA 0P ig8dE. 4 R H AT LUER] Import dataset
CRAEIEE) ETl. ) 1 T T e A8

oMl M Excel XIS
1. A www.uv.es/vcoll/Coll Blasco 2006.xlsx FERFIEGE, FHEZSUHEEE
IRB “Paper 1" WIS,

2. 7£ RStudio MR A & H [ Environment 2851, FA13EFE Import Dataset <
From Excel (Z0&] 15) .

11
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Data Envelopment Analysis with deaR

15: M Excel S NEE
o

C:/Users/Vicente/Desktop/Paper_1 - Rstudio - o IEN
Fle Edt Code View Plots Session Buld Debug Profile Tooks Help
@] Untitled!* = History G =l
ScurceonSave | O - FRun o+ Source = 2 l ' List =
1 library(dear)
2 Y T Giobal From Text (base)...
From Text (readr)..

From SPSS...

From SAS..

From Stata.
Files Plots Packages Help Viewer =

Q] New Folder | '@ Delete = Rename gk More =
C: © Users  Vicente = Desktop * Paper_t &
A Name Sze Modified
Top Level) = R Saipt 2 t.
- | Rhistory 168 Nov 2, 2018, 9:44 Al
Console C:/Users/Vicente/Deskto ser - =
= = &/ Paper_1.Rproj 2188 Nov 2, 2018, 9:56 Al
The following objects are masked from ‘package:stats’: 9 sesion 1R 478 Nov 1, 2018, 11:26/
% Coll_Blasco_2006.xlsx B84KB Oct 14, 2018, 2202 P
filter, lag

The following objects are masked from ‘package:base’:
intersect, setdiff, setequal, union
warning message:

package ‘dplyr’ was built under R version 3.4.4
>

3.%F Import Excel Data OfTHFHfE, A i Browse &
“Coll_Blasco_2006.xIsx" %, %XJ5 riii Open %4l (Z WK 16) .

Excel X {4

16: 5N\ “Coll_Blasco_2006.xlsx”

[E] C/Users/Vicente/Desktop/Paper_1 - RStudio -8
File Edit Code View Plots Session Build Debug Profile Tools Help

@ | Untitled1* =l History  C =
= = " == T L ’
- List ~
. Impoart Excel Data
1 Tibrg
2 )
File/Url:
Data Preview:
(2] Choose File
L] b Paper_l v| & |  BuscarenPaper r
Organizar v Nueva carpeta = A ®
=
A N
7 Favorites e !
1 |Auth¢
18 Descargas Rprojuser & 3
B Escritorio 22— e
| 1 sitios recientes b —
21 (Tog % Dropbox s . 02/11/2018 RO
# ownClaud @) sesion_1 D1/11/2018 11:26 a2t 2, 2018, 9:44 Al
6

|
Eonete - Import Options: o 2,2018, 9:56 Al
& Grupo en el hogar S
The follow ], 2018, 11:26/
Name;  dataset [ = ULL)
i 1% Este equipo 4,2018,2:02P
ilten
Sheet  Default < & Descargas
Documentos
The follow Range: » I Escritorio
. £l Imaaenes X I 2
inters

warning me
package ‘d
>

7' Reading Excel files using readxl

Nombre: | Coll_Blasco_2006

<

<

Cancel

4, BAE, FATAT LB S NEHE LRI AL “ Coll_Blasco_2006.xIsx” o K
s, HTRAHEN R RBERERTONG N (Z0E 17) . £ T Open
Data Viewer IEIICLAM L3, BAREMIE S AT AR H. A5, HAT
iy Import 1241

2 Coll-Serrano, V.; Blasco-Blasco, O. (2006). Evaluacidn de la Eficiencia mediante el Andlisis Envolvente de Datos.
Introduccion a los Modelos Bdsicos. www.eumed.net/libros/2006¢/197/

3BT R ARAS: View(Coll_Blasco_2006)

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)
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Data Envelopment Analysis with deaR dR

17: Bl i
LX)

CfUsers/Vicente/Desktop/Paper_1 - RStudio - g “_
File Edt Code View Plots Session Build Debug Profle Tock Help
O | Untitled1* - History  C =
import Excel Data ’ S
1 1ibrg 'mPoT =
2
File/Urk:

( IC;a’UsetancentefDesk:op.-‘Paper_|;COII_B@ Browse...
IData Preview: I

Authorized_dealer Employees Capital Vehicles Orders
(character) (double) (double) (double) (double)
A 8 8 14 20 =
8 1 15 25 42 =0
c 4 12 & 30
D 12 13 25 8 s
F 11 18 an E ] . E
F (Tl | Previewing first 50 entries.
ol 12018, 944 Al
Console C/ > - 0y 1
- Import Options: L) s01s, 956 a

The follow — Tibrary(readx1) |, 2018, 11226
Name: | Coll_Blasco_2006 Max Rows: Coll_Blasco_2006 <- read_exce

i1 i e T 4,2018, 202 P
ilte i i .
Sheet  Default = Skip: 0 I + Open Data Viewer | Jiiew(col B 13_5:0_2006 -l

The follow Range: A

inters
warning me (7 Reading Excel files using read:d @ Cancel
package ‘d -
o w

5. #i5f; Import FiHJG, BATHLIR BB E “Paper 17 HIEE T, WIAHSA
(BRI R FE R LAER D Ce SERENEZHMRD (ZIE 18) . [,
fE Environment 3R ChH EFED T4 BomATE R P EIE K FTA X3
(object) *fly5I%. HLLE, RATH—ARI%, B “Coll Blasco_2006" » 5k
b, IR RE—NMEET 6 MUWINME (observation) F1 5 /M8 (variable)

PIEARHE (dataframe)

K2 “ »

18: WiH “Paper_ 1

e C:/Users/Vicente/Desktop/Paper_1 - RStudio - g n_
File Edit Code View Plots Session Build Debug Profile Tools Help

Q'] Untitled1* Coll_Blasco_2006 = mehry c i =0
1 A

Filter Import Dataset = | List =
“  Authorized dealer Employees Capital Vehicles Orders % Global Environment =
1A 8 8 14 20 Data
28 1 15 25 a2 Ii_.SCU'I'LB'lascDJU.. 6 obs. of 5 variab'lesl
3 C 14 12 8 30
4 D 12 13 25 8
5| E " 18 40 22
6 F 18 20 24 30
Showing 1 to 6 of 6 entries Fitas, | Dioke || Bacingas | Fraig )] Viewar =
Console C:/Users/Vicente/Desktop/Paper_1 - @ New Folder | ©  Delete = Rename | & More -
~ C: * Users * Vicente ~ Desktop - Paper_1 R
A Name Size Modified
Attaching package: ‘deaR’ t+
The following object is masked _by_ *.Globalenv': '] Rhistory 6.7 KB Nov 11,2018, 441 PM
| Coll_Blasco_2006.xlsx 84 KB Oct 14, 2018, 2:02 PM
Col1_Blasco_2006 i
& Paper_1.Rproj 2188 Nov 14, 2018, 4:16 PM
warning message: @7 session_1.R 478 Nov 1,2018, 11:26 AM

dplvr was built under R version 3.4.4

> library(readx1)

warning message:

package ‘readx1’ was built under R version 3.4.4

> Coll_Blasco_2006 <- read_excel("Coll_Blasco_2006.x1sx")
> View(Coll_Blasco_2006)

1E Console THARH, FATAILLERIH T SAEHER R AL (LK 18)

R P — DI HEIE A AR R (object) « — X RATLLE—MEIESE, — MR, —%E4, — 1M
PRI, 545,
13
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Data Envelopment Analysis with deaR dR

e library(readxl) > % “readx!” £

e Coll_Blasco_2006 <- read_excel(“Coll_Blasco_2006.xIsx”) > B %X
“read_excel” CRHAT readix 1) R SCE, R ZEEE L (“<-
“) XS “Coll_Blasco 2006”7

HERR:

RAIE: A<-BETHB (LR BZA MRS, I, —IMHEFME. 5
B HNEE RS Pl (<) BIXWR A

e View(Coll_Blasco_2006) > R #{LXt % “Coll_Blasco_2006”

6. FAELL LA EHIZIBIA “Uuntitled1” , K53 1FAr44 08 “session_2” I RAF
A

XE, BERADEST RN TITENE (IE 19 .

Kl 19: RAFHIA “session_2”
tF’\IE Edit Code View Plots Session Build Debug Profile Tools Help

Coll_Biasco_2006 =" i History ~ Connecti =

| Source on Save I ®Run | O Source = “ ™ | #* Import Dataset = | & List =

C:/Users/Vicente/Desktop/Paper_1 - RStudio - o IEl

; Tibrary(deaR) "} Global Environment
3 library(readx1) bata
4 Coll_Blasco_2006 read_excel ("Col1_Blasco_2006.x1sx") Coll_Blasco_20. 6 obs. of 5 variables
5 View(Coll_Blasco_2006)
6
6:1 (Top Level) < R Script < Files Plots Packages Help Viewer P |
T N e T .~ @nNewFoider | © Delete | Rename 4 More -
a C: > Users * Vicente - Desktop * Paper_1 R
A Name Size Modified
Attaching package: ‘deaR’ 1+
The following object is masked _by_ *‘.GlobalEnv’: "] Rhistory 6.7KB Nov 11,2018, 4:41 PM
| Coll_Blasco_2006.xlsx 84 KB Oct 14, 2018, 2:02 PM
toll_Blasco 2006 &l Paper_1.Rproj 2188 Nov 14, 2018, 4:16 PM
warning message: 0 | ceccion 1R 47 B Nov 1,2018, 11:26 AM
package ‘dplyr’ was built under R version 3.4.4 1578 Nov 2,2018, 11:28 AM
> library(readx1) - g

warning message:

package ‘readx1’ was built under R version 3.4.4

> Col1_Blasco_2006 <- read_excel("Coll_Blasco_2006.x1sx")
> View(Col1_Blasco_2006)

>

ANFELFSW A TEFEEHAT UL L 1-5 25, KNI CLE 28RS 44
1FAE T XX “session_2.R” o WIREFIXM “Coll_Blasco_2006.xIsx” ‘F N,
BATR 75 BHEPAT “session_2.R” AR A RIA]

deaR LR ML RIHHEE (dataset) . XLEEHHEAR A T HLKCE AT RERISTHR,
I ERX SR A R . AT, XS deaR AW FLN AT A& SR (1 —

14
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Data Envelopment Analysis with deaR dR«

ANEREBINE, EOvE T AR ARSCRFREE AT > DEA HIJ7AR . FATTA] LLIE
RARAN deaR FEBIE B5K 1 A€ ROEE S5 H AR

IR, FATRIRB 2 BoRinrinsc#dE S (dataset) .

EER: 7= deaR HimEel i %R se
BAE deaR TR B, ATEANIFHATEL RS
data(package="deaR"”)

20: deaR L HHESE

C:/Users/Vicente/Desktop/Paper_1 - RStudio = O n_
File Edit Code View Plots Session Build Debug Profile Tools Help
O | session_2.R* = History  C =y
2 | #* Import Dataset = )’ List =
: y \ - 2 & Global Environment ~
Data sets in package ‘deaR’:
Data

Coll_Blasco_2006 Data: Coll and Blasco (2006). )Coll_Blasco 20. 16 obs. of 5 variables

Departments Data: Tomkins and Green (1988).
Doyle Green 1994 Data: Doyle and Green (1994).
Economy Data: Wang and Lan (2011).
EconomyLong Data: Wang and Lan (2011).
Electric plants Data: Fire, Grosskopf and Kokkelenberg
(1989) .
Fortune500 Data: zhu (2014).
Fried1993 Data: Fried, Knox Lovell and Schmidt
(1993) .
Golany Roll 1989 Data: Golany and Roll (1889). v  Files Plots Packages Help Viewer [
Console C:/Users/Vicente/Desktop/Paper = @0 NewFolder | © Delete = Rename | g More -
~ C: » Users * Vicente * Desktop ’ Paper_1 R
Attaching package: ‘deaR’ A Name Size Modified
: " y
The following object is masked _by_ ‘.GlobalEnv’:
o -Rhistory 6.7 KB Nov 11,2018, 4:41 PM

Coll_Blasco_2006 "] Coll_Blasco_2006.xisx 84KB Oct 14,2018, 202 PM

. B i
o LR Paper_1.Rproj 2188 Nov 14, 2018, 4:16 PM
package ‘dplyr’ was built under R version 3.4.4 9] session_1.R 478 Nov 1, 2018, 11:26 AM
> 1ibrary(readx1) ©) session_2R 1578 Nov 2, 2018, 11:28 AM

warning message:

package ‘readx1’ was built under R version 3.4.4

> Coll_Blasco_2006 <- read_excel("Coll_Blasco_2006.x1sx")
> View(Col1_Blasco_2006)

> data(package="dear")

>
v

IS, AT EAE A data()BRE. #lan, FRATEM Tomkins and Green (1988)°H"
s, ZEIEEN LIRS “Departments” o N, BATERIA “session2.R” 1’5
AL TS (ZHHE21) -

data(“Departments”)
BETIAEIESE, BT (ZHE 20D -

View(Departments)

SHREL R BB E R, 15 A 8EEE:  http://www.r-project.org/help.html

® Tomkins, C.; Green, R. (1988). "An Experiment in the Use of Data Envelopment Analysis for Evaluating the
Efficiency of UK University Departments of Accounting”, Financial Accountability and Management, 4(2), 147-
164. https://doi.org/10.1111/j.1468-0408.1988.tb00296.x

15
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Data Envelopment Analysis with deaR

21 WA AR

C/Users/Vicente/Desktop/Paper_1 - RStudio - 3 “_
File Edit Code View Plots Session Buld Debug Profile Tools Help
Q| sesion_2R Departments __| R data sets - Environment  History Connections =
Sourceon Save | O A~ #Run "% =Source -~ = = [ | [ importDataset = | & List ~
; Tibrary(deaR) B Global Environment =
3 Tibrary(readx1) Data
4 Col1_Blasco_2006 <- read_excel("Col1_Blasco_2006.x1sx") ©cColl_Blasco_20.. 6 obs. of 5 variables
5 S =
6 data(package "dear™) O Departments 20 obs. of 11 variables
7
8 data("Departments")
9 view(Departments)
10
Files Plots Packages Help \Viewer -
Q) NewFolder | @ Dalete = Rename | 4gF More ~
C: © Users - Vicente ~ Desktop - Paper_1 i
A Name Size Modified
10:1 | (Top Level 3 RScript 2 | S
= & RData 2B KB Nov 2, 2018, 11:09 AM
Console C/Users e/Desktop = )
> library(dear) "] .Rhistory 1258 Nov 2, 2018, 11:09 AM
> 1ibrary(readx1) | Coll_Blasco_2006.xlsx B4 KB Oct 14, 2018, 202 PM
> Coll_Blasco_2006 <- read_excel("Coll_Blasco_2006.x1sx™) 3 ;
= = - o = P 1. 1 , 2018, 11:17 AM
> data(package="deaR") ‘aper_1.Rproj 2188 Nov 2,2018, 11:17 A
> data("Departments™) 0] sesion_1.R 47 B Nov 1, 2018, 11:26 AM
> View(Departments) @ sesion_2R 1578 Nov 2, 2018, 11:28 AM
%
— /_
A)
mdr R FHEEATIRS (ALK 22)
d “« ”
22: “Departments
(2] C:/Users/Vicente/Desktop/Paper_1 - RStudio - g “_
File Edit Code View Plots Session Build Debug Profile Tools Help
Q| session_2R | R data sets - Environment History Connections |
" Filter =l | ¥ Import Dataset = }’ List ~ 5
“ Departments Undergrad Research_post Taught_post Res_co_income Oth 1 Global Environment ~
1 Departmentl 128.70 4 6 o ~ Data
2 Department2 8335 9 0 5 Coll_Blasco 2 of 5 variables
]
3 Department3 92.77 10 10 2182 P oEpSrtments 20 ohs
4 Departmentd 80.03 4 a 0 -
Af")
5 Departments 119.85 3 14 0 \\"\,;‘))
6 Department6 112.69 4 25 150
v
< >
Showing 1 to 7 of 20 entries Files Plots Packages Help Viewer h
<l = ~k
Console C:/Users/Vicente/Desktop/Paper_1/ ﬂ:c o= NewFolder | © Delete = Rename {aMWE
> library(deaR) C:  Users ~ Vicente - Desktop * Paper_1 R
> Tibrary(readx1) A Name Size Modified
> Coll1_Blasco_2006 <- read_excel("Coll_Blasco_2006.x1sx") +
> View(Coll_Blasco_2006) i
> data(package="deaR") @] RData 36KB Nov 14, 2018, 4:45 PM
> data("Departments") "] Rhistory 7KB Nov 14, 2018, 4:45 PM
> View(Departments) "y
> | Coll_Blasco_2006.xlIsx 84 KB Oct 14, 2018, 202~d
& Paper_1.Rproj 2188 Nov 14,2018, 445’1’hﬁj
©7 session_1R 478B Nov 1,2018, 11:26 AM
@) session_2R 1818 Nov 14, 2018, 4:44 PM

T—E%: WATIAEH WA X 5
“Departments”

NME & (variable) HIEAEHE .

T MILET 20 NUIME (observation, Bl DMU:

“ Coll_Blasco_2006 ” #1 “ Departments” ,
WA A A 11

H

AE, BAIRTF

“session_2.R”

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)
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Data Envelopment Analysis with deaR dR«

7.2. 1R4% deaR THE LI

InEEE e, 7FEHAS AT RE, DMET deaR REWSIIUFIEZEUEA]. deaR A =7
ANFEIEAR S R, AN RS — NREE Y DEA model AHXTRL, ixX e PR 52 Y
PRI «
Read_data(): Fi T-iZ4T conventional DEA model ({£%; DEA %Y .
Read_malmquist(): i 7347 Malmquist productivity index (Malmquist 4=7= /115
B B,
Read_data_fuzzy(): H T84T &H A £ HE (uncertain data) ) DEA model
(fuzzy DEA)

7.2.1. M deaR JREUESBh?

FATATLLEIE deaR [ help (FEBh) DhRESE > U KR € IR BRI BE 350 T34 b
IR ZEAE Bl BT 261 3 FE7m anf {1 deaR 1 help FI%L

ENGE: #KEX deaR #B)
1. 3T H W H “Paper 1” , Gl —NHHBHA, B HaH N

“example_read_data” .

2. in%; deaR
3. IN#H deaR UL EHELE (dataset) “Coll_Blasco_2006” (SN 23) .

23: n#EEHESE “Coll_Blasco_2006"
[E]

C:/Users/Vicente/Desktop/Paper_1 - RStudio - a “_
File Edt Code View Plots Session Build Debug Profile Tools Help

©'| example_read_dataR —[™  Environment History Connections —r
: SourceonSave | QA7 - +fun | o4 Source = 2 [ | C# import Dataset » | & List =
é library(deaR) Tk Global Environment =
3 data("Coll_Blasco_2006") values
;1 Coll_Blasco_20.

41 (Top Level) 2 RScript = Files Plots Packages Help Viewer ="
Coicle CTUss T NI A Dk PRBAEA - Q1 New Folder | ©  Delete | Rename | gk More -
Loading required package: dplyr " C » Users - Vicente - Desktop - Paper_t
A Name Size Modified
Attaching package: ‘dplyr’ T
The following objects are masked from ‘package:stats’: @] RData 36KB Nov 14, 2018, 4:45 PM
y “ 1 Rhistory 73 KB Nov 14, 2018, 452 PM
filter, lag
| Coll_Blasco_2006.xlsx 84 KB Oct 14,2018, 2:02 PM
The following objects are masked from ‘package:base’: © ] example_read_data.R 458 Nov 14, 2018, 4:52 PM
» . < & paper_1.Rproj 2188 Nov 14, 2018, 4:52 PM
intersect, setdiff, setequal, union
0 session_1R 47B Nov 1, 2018, 11:26 AM
warning message: @] session 2R 1818 Nov 14, 2018, 4:44 PM

package ‘dplyr’ was built under R version 3.4.4
> data("col1_Blasco_2006")
>

ZLU7 A deaR BAF W RECCH, FRATE help()ifiZ. B A:
help(package="deaR")

TR T R BUAEEL, 1E S dEEEE:  https://www.r-project.org/help.html

17
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7E Help EHd CHTFHEED ¥E~ deaR A REFEIELE (dataset) 7
Fo BEWE deaR BB (LK 24) .

I 24: M deaR $RIXH B

C:/Users/Vicente/Desktop/Paper_1 - RStudio - o IEN
file Edit Code View Plots Session Build Debug Profile Tocls Help
@' example_read_data.R* - History  C =
b Source on Save L 7 - e d * Source  ~ = | # Import Dataset = & List =
% Tibrary(deaR) Mk Global Environment =
3 data("col1_Blasco_2006") Vvalues
4 Col1_Blasco_20.
5 |help(package-"dearR")
6

Files Plots Packages Viewer =0

| @ e

R: Conventional and Fuzzy Data Envelopment Analysis =

e e v - CONventional and Fuzzy Data
Consale C:/Use

rs/Vicente/Desktop/Paper_1/ = ',, Envelopment Analysis
Attaching package: ‘dplyr’ i

The following objects are masked from ‘package:stats’:
filter, lag ﬂh ’“

The following objects are masked from ‘package:base’:

intersect, setdiff, setequal, union

|Documentation for package 'deaR’|version
warning message:

package ‘dplyr’ was built under R version 3.4.4 :
" " * DESCRIPTION file
> data("col1_Blasco_2006") RIPTION file

> help(package="dear")
>

. Help Pages v

7.2.2. read_data()ER%X

Piin 7 deaR ) Chelp) XRY)GE, AR LLEE i “read data” BE3E3RASH R ILEREL

HIREE B . FRATTH AT DLl 7R A o 5N AT LA 48 2 3R1SAH R 1 25 2R
help(read_data) (E{# ?read_data)

Usage 535 T read_data()BREUIITA 240, beab, FATIER LALE Arguments 5315k

FIRTIX SR ZEU (WK 25)

25: read_data() BRI B FE I E B

[E] C:/Users/Vicente/Desktop/Paper_1 - RStudio - n_
File Edit Code View Plots Session Build Debug Profile Tools Help

Q| example_read_dataR* = [ Environment History Connections =0
=] Source on Save L S~ *Run % * Source - + H “* Import Dataset ~ 3‘ List =
% library(dear) ] Global Environment ~
3 data("Coll_Blasco_2006") Values
4 Coll_Blasco_20..
5 help(package="deaR")
6

i}
0

Files Plots Packages Vlmr
9 A

cente/Desktop/Paper_1 == [T  Riread_data ~

6:1 (Top Level) < R Script =

Console C:/Users/V

Attaching package: ‘dplyr’ I'ea_ ata

The following objects are masked from ‘package:stats’: Description

filter, lag This function creates, from a data frame, a deadata structure, which is as list
with fields input, output, dmunames, nc_inputs, nc_outputs,
nd_inputs, nd_outputs

intersect, setdiff, setequal, union

warning message:

The following objects are masked from ‘package:base’:

package ‘dplyr’ was built under R version 3.4.4 read_data(datadea,

> data("col1_Blasco_2006") dIS\US =1,

> help(package="deaR") ni = NULL,

> no = NULL, v
L < >

18
©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)
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read_data()BRECKH A NS4

datadea: & — N EEE (HAL G002 —PMEARHIED |

dmus: DMU JITfES %5 . BRNIKE T, deaR 8 DMU B T-HHR LM —51.
ni:inputs  CIN) &

no: outputs (i) M=

inputs: T 488 input FRFERIZII SR 5, 1A input FIEE

Outputs: F1 T8 8] output FTTEMIFI %5, A output AR

nc_inputs: WIHA non-controllable inputs (CATT#EEIN) , 7] H TH5 B EA T2 W

e

nc_outputs: WA non-controllable outputs (ANE[FEHH) , A THREIEATE
2

nd_inputs: U154 non-discretionary inputs (IEH FALHAN) , "I HTIEHTATE
12

nd_outputs: IR non-discretionary outputs (AEHFHiH) , ATH TP E
(NPTt

ud_inputs: WS4 undesirable (bad) inputs (AR/RFIAN) , AIHTIRFENZ
W sk

ud_outputs: WHEH undesirable (bad) outputs (AR /REH) , v T8 EA]

s WL

A 4 s T A read_data()eRiE. deaR SCRSMIFRHE T FAF 00 B TR pR £ 45

il

R 157 read_data() %L

HEr, JA1CHNE T H3ES%E “coll Blasco 2006” . ZEIEER 6 > DMU (55 1 %))
2 Ninput (8 2 ZIAIZE 3 41D K 2 /> output (25 4 FIFIZE 5 %)) &

{5 AT AR LI 12 H] BCC DEA model SRl EHX 6 DMU (ALK

T BCC BCC model 7&—)> conventional DEA model (‘&I +2& fuzzy DEA model) , FA/]
WAE A read_data() BRES R UG BIEERT & deaR L HUS

PAVEPIA “example_read_data” F'H5ANLL T4 (S0 26)

data_example <- read_data(Coll_Blasco_2006, ni=2, no=2)

FREE: HEFEBRES
MEFS (<) AMARENFLR: HH Coll_Blasco_2006 H i) ¥ ¥

(read_data) ; B 2 /> input (ni=2) F12 /> output (no=2) . DMU TEZf

1% (dmus=1) , EEXBEHSHASHI, FAELEBME.
N, BIERBUN S R e (<o) X4 data_example .
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Data Envelopment Analysis with deaR dR«

M ZHPATIR S O Lo, )
THIER, U Environment SEEFH T “Coll_Blasco_2006” F11 “data_example” P4t
%, FHH “data_example” &—NMIE T 9 NMAFRIFIER (S HE 26) .

K 26: {#H read_data()hi%k
)

File Edit Code View Plots Session Build Debug Profile Tools Help

O | example_read_dataR* _r o History | G 3 —n
| Source on Save P = Run o '

2 ) Source ~ I #* Import Dataset - & List =

C:/Users/Vicente/Desktop/Paper_1 - RStudio -8 “_

1ibrary(deaR) & Global Environment =

data("coll_Blasco_2006") Data
»Coll_Blasco_20.. 6 obs. of 5 variables
[. data_example List of 9 I

data_example <- read_data(Coll_Blasco_2006,

1
2
3
4
5 help(package="deaR")
6
8
9
0

ni=2,
no=2)
1
Files Plots Packages Help Viewer =
10:1 (Top Level) = R Seript 5 - /.\
Console C:/Users/Vicente/Desktop/Paper_1 e=[_  Reoread data -
The following objects are masked from ‘package:stats’: ~ A
B R read_data
filter, lag
Description

The following objects are masked from ‘package:base’:

This function creates, from a data frame, a deadata structure, which is as list
with fields input, output, dmunames, nc_inputs, nc_outputs,
nd_inputs, nd_outputs

intersect, setdiff, setequal, union

warning message:
package ‘dplyr’ was built under R version 3.4.4

> data("Coll1_Blasco_2006") Usage

> help(package="deaR") .

> data_example <- read_data(Col1_Blasco_2006, read_data(datadea,

4 ni=2, iy = L

5 no=2) ni = NULL,

S no = NULL, v

WZE, BRI #E% S conventional DEA model —#{HH T (ZWHE 73T . A
e, FATROZAEH AT Z ATEI 2 FIXT R :  “data_example” -

B TSR R R R 5 ST read_data() BRER

Save “example_read_data.R”.

7.2.3. read_malmquist() &%t

WARFATE B A5 EHE (time series data) f HAHZL & Malmquist productivity index
(Malmaquist 2272 71#8%0 , st ZE H read_malmauist() B LMEEHE ST & deaR 3L
g =K.

deaR RERL LN FhAS [E] 4% W IS 18] 7 51 238 (time series data) -

e Wide format: DMU 1% %1%, input A1 output 43 AR HE A [5] R[] B 4% 1) 51
Ho Rl iEZE deaR T “Economy” ¥iiE£Ee (ZILKE 27) .

e Long format: [f[A]#%%1%]H, DMU. input il output % [&}1E]42H J5 #4251 51
Ho w~¥l: HSFE deaR HH] “Economylong” HHiEE (S LK 28) .

FATRAERE T R 1 7= Bl s DA B B

8Wang, V.; Lan, Y. (2011). "Measuring Malmquist Productiviy Index: A New Approach Based on Double
Frontiers Data Envelopment Analysis". Mathematical and Computer Modelling, 54, 2760-
2771. https://doi.org/10.1016/j.mcm.2011.06.064

20
©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)



Data Envelopment Analysis with deaR dR«

: Wide and Long data formats.
WAL, BTATIE— R X PIAPA B is 2. [t
1. B — NI, BHm %N “example_read_malmquist” .
fe: WERCAKH T TAESEE L, T ITIUH “Paper_17, SR8 )5 BIEE AR,
[t 75 2N 2K deaR.
2. 7F deaR HIN#EEIEE “Economy” (VLK 27) .

3. A4 “Economy” , —IU\%@J X% (CBdESE) A 31 > DMU. 2 4 input
(Capital F Labor) & 1 4> output (GIOV) , KEIECH 5 4F (2005 % 2009) . fiT
PL, “Economy” —/\Eﬁ wide forma % =U I E AR £

K 27: Wide data format #&zUEdE “Economy”

[E] C:/Users/Vicente/Desktop/Paper_1 - RStudio -9 “_
File Edit Code View Plots Session Build Debug Profie Taols Help

Q'] example_read_data.R* 0| example_read_data_malmquist.R” - Environment  History  Connections =0

Filter =l ¥ | £* Import Dataset ~ '4 List =
“ DMUs Capital2005 Labor2005 GIOV2005 Capital2006 Labor2006 ik Global Environment ~
1 Beijing 12829.79 116.97 6346.07 1424440 117.3¢~ Data
2 Tianjin 6347.92 12217 6774.10 7129.02 1163: | @ Col1_Blasco 20.. 6 obs. of 5 variables
3 Hebe 947370 20221 1100812 1125085 w33 | [Qdataexamle  List of 9 .
|© Economy 31 obs. of 16 variables]
4 Shanui_1 704509 213.20 485091 6865.50 2205¢
§ Neimenggu 459589 83.70 2995.59 5605.92 907z
€ Lizoning 1190212 276.55 1081451 14140.89 303.02
v
= Files Plots Packages Help Viewer =
Showing 1 t 1 -
""""" 2 Q0 NewFolder @ Delete & Rename = 4 More -
Console C:/Users te/Desktop/Pape | € Users  Vicente  Desktop * Paper_1 X
filter, '\aq 7 A Name Size Modified
The following objects are masked from ‘package:base’: @] RData S Nov 14,2018, 4:45 PM
intersect, setdiff, setequal, union = | Rhistory 73KB Nov 14,2018, 452 PM
. _] Coll_Blasco_2006.xIsx 84 KB Oct 14, 2018, 2:02 PM
warning message: @
package ‘dplyr’ was built under R version 3.4.4 | example_read_dataR 458 Nov 14,2018, 4:52 PM
> data("Col1_Blasco_2006") &) Paper_1.Rproj 2188 Nov 14, 2018, 4:52 PM
> help(package="dear") o :
> data_example <- read_data(Coll_Blasco_2006, J session_1.R ALH Nov/ 208 I :Z26:AM
+ ni=2, @7 session_2R 1818 Nov 14, 2018, 4:44 PM
- - no=2) 9| example_read_data_malmquistR 3018 Nov 8, 2018, 5:06 PM
> data( Economy™)
> View(Economy)
>

4. 9 Rk, InEEdESE “Economylong”

5. A4k “Economylong” JEFTLAEH] (B 28) , XANHIM R W5 (b b
T MEIEE) F 155 MMIMME (31DMU x 5 4) . 2 /N input (Capital 1 Labor)
A1 output (GIOV) 5 B A4 FR 7R R 1] BE R 2005 4E 28 2009 4.
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Data Envelopment Analysis with deaR dR

K 28: Long data format /&= #E “Economylong”
o

C:/Users/Vicente/Desktop/Paper_1 - RStudio - IEN
file Edit Code View Plots Session Buid Debug Profile Tools Help

read_data.R* O | example_read_data_malmquistR* EconomyLong Economy 3  m [™ Environment  History Connections =

Filter 2 & | 7 import Dataset ~ | & st =

* pMus Period Capital Labor Glov T Global Environment ~

1 Beijing 2005 1282979 11697 694607 ~ Data

2 Tianjin 2005 634792 12217 677410 Co11_Blasco_20.. 6 obs. of 5 variables

3 Hebei 2005 947370 29221 11008.12 D data_example List of 9

Economy 31 obs. of 16 variables
4 Shanxi_1 2005 7045.09 21320 485091 -
| EconomyLong 155 obs. of 5 vamamesl

5 Neimenggu 2005 459589 8370 299559

6 Liaoning 2005 1190212 27655 1081451

7 il 2005 4506.88 10183 3791.96

= = Y Files Plots Packages Help Viewer =
Showing 1 to 7 of 155 entries :
e R Q| NewFolder | @ Delete = Rename | g More ~
Console Users/Vicente/Desktop/Paper_1 = C:  Users = Vicente = Desktop =~ Paper_1 - .
The following objects are masked from ‘package:base’: A A Name Size Modified
t

5 . iF :

intersect, setdiff, setequal, union O Rpata 16K8 Nov 14, 2018, 445 PM
warning message: Y] Rhistory 73 KB Nov 14,2018, 4:52 PM
package ‘dplyr’ was built under R version 3.4.4 ] Coll_Blasco_2006.xlsx 84 KB Oct 14, 2018, 202 PM
> data("Col1_Blasco_2006")
> help(package="dear™) 97 example_read_data.R 458 Nov 14, 2018, 4:52 PM
> data_example <- read,éata(cc‘ﬂLBWascu,ZOOB. E| paper_1.Rproj 218B Nov 14,2018, 4:52 PM
% nisi, © session_1.R 478 Nov 1,2018, 11:26 AM
+ no=2)
> data("Economy™) @7 session_2.R 181B Nov 14, 2018, 4:44 PM

: S @] example_read_data_malmquistR 3018 Nov 8, 2018, 5:06 PM

> data("EconomyLong")
> View(EconomyLong)
>

1 TAES TR RN BT A X % 882 7R TE Environment S8 CF B&E D &

read_malmaquist()BRECKH L NS4 °

datadea: '€ & — MEHEE (HLI0E —NEIEHE) .
nper: TFEL (CHERE A wide format)
percol: ZF FE i A T fE 15 9% 5 (Bidats: long format)

arrangement: wide format % EHE 1) “/KFHES” (horizontal) BX# long format
M AR “FEEHS” (vertical)

dmus: DMU JT7EFI 25 . BRINIZE T, deaR 48 DMU B T HIEEMEH —71,
ni: inputs  CIAN) HIEE

no: outputs CHii) M%E

inputs: Al T8 8 input FrEMII 9% 5, A input F3E

outputs: 1 T-48 8] output FTTEMIFI %R 5, A2 output M E

nc_inputs: WA non-controllable inputs (CARIFEHIN) , A HT45 B EAT &M
e

nc_outputs: WA non-controllable outputs (ANE[E# D , BT EA1E
IR £

nd_inputs: W4 non-discretionary inputs (IEH FALHA) , 7 HTEHEA1Z
R £

nd_outputs: WIHEF non-discretionary outputs (JEHFAHIH) , ATHTRHE
T2 e L

9 See help(read_malmquist).
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Data Envelopment Analysis with deaR

dR

e ud_inputs: WA undesirable (bad) inputs (ANE/ERFIAND , BT EA1E

e ud _outputs: W1HA undesirable (bad) outputs (AR /&iH) , A HFHEHEA]

R

MHTHRAS ) deaR Jovkiz A undesirable inputs/outputs 115 Malmquist productivity index,
{HILTHRER B BRI R A

R 6 FRB 7 23 AR T %%t wide format #& Z0EFE AT long format #% X\ i iz

H read_malmquist() & %L

: wide format &2\ read_malmquist() &%
FEIXN R, FRATEASE FHEAESE “Economy” . ZEHEE CLPINER T 4 u7 ) TI/E

U

N A
FEANLLR SO

data_example_1 <- read_malmquist(Economy,

nper=5,

arrangement="horizontal”,

ni=2,
no=1)

“Economy” f§4& deaR HIEHUME X, FRMNTEMIA “example_read_malmquist”

PATHR A G, — DH WX R  “data_example_1” ) HAIEH KT, € RRTE
Environment S (ZWE 29)

29: wide data format ¥ 201 read_malmquist() B £k

" RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help G 9 = o) 91% @ Juel5nov 11:57 Vicente Q =
ece ~/Desktop/Paper_1 - RStudio
¢ - Todid ~ Addins - i Paper_l -
2xample_read_data R* @ | example_read_data_malmquist.R* Economylong Economy % =[] Environment History Connections i
Source on Save A - =Run | *= Source ~ ol ~ Import Dataset ~ | & List -

1 dataC"Economy”) 7k Clobal Envirenment -

i View(Economy) Data

4 dataC"Economylong™) Coll_Blasco_2086 6 obs. of 5 variables

5 View(EconomylLong) data_exgmala i of 9

! :

; data_example_1 <- read,malmqu\st(i:::z:{, =PT""of 16 variables

9 arrangement - “horizontal, EconomyLong 155 obs. of 5 variables

10 ni=z,

11 no=1)

12

Files Plots Packages Help Viewer ]

12:1  (Top Level) :

Console ~/Desktop/Paper

> data("Economy”)

> View(Economy)

> data("Economylong™)

> View(EconomyLong)

> data_example_1 <- read_malmquist(Economy,
nper=5,

ni=Z,
no=1)

N+t

© | New Folder | © Delete - Rename {3 More -

/) Home  Desktop * Paper_1
4 Name
t.
@) RData
. .Rhistory
=] Coll_Blasco_2006.xIsx

example_read_data.R

R Script

example_read_data_malmquist.R
Paper_1.Rproj

session_L.R

©°m @®

session_2.R

arrangement = "horizontal",

3.6 KB
7.4 KB
8.4 KB
1188
2918
2058
47B

1818

Modified

Nov 14, 2018, 4:45 PM
Nov 14, 2018, 5:18 PM
Oct 14, 2018, 2:02 PM
Nov 15, 2018, 11:53 AM
Nov 15, 2018, 11:56 AM
Nov 15, 2018, 11:51 AM
Nov 1, 2018, 11:26 AM
Nov 14, 2018, 4:45 PM

AT UE 2,
IRSFIARIERS

©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)

“data_example_1” 72— N&H 5 NMHHMFIER. WRBIRI R
WRER BZA G BARg e (0K 30) .
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Data Envelopment Analysis with deaR

30: “data_example_17 #hi¥)

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help =] O = o) 9% @@ Juel5nov 1:58 Vicente Q
[ NoN ) ~/Desktop/Paper_1 - RStudio
S -8 o+ . - « Addins * R Paper_L v
2xample_read_dataR* « @ | example_read_data_malmquist.R* " |EconomyLong Economy % [7] Environment History Connections =M
SourceonSave 4, /- +Run | >+ Source + g # Import Dataset = | & List +
1 data("Economy") 7} Global Envirenment ~
; View(Economy) Data
4 data("Economylong”) © Coll_Blasco_20@6 6 obs. of 5 variables
5 View(Economylong) ! data_example List of 9
6 . @ Jata_example_1 List of 5
; data_example_1 <- read,mulmqulst[ﬁ;g:z:y, Period 1:List OF 9
i mmngémmt - “horizontal”, ..$ input : num [1:2, 1:31] 12830 117 6348 122 9474 ...
10 i ..- attr(*, "dimnames®)=List of 2
11 ..8 1 chr [1:2] "Capital2@@5" "Laborzeas"
1z = ..% : chr [1:31] "Beijing" "Tianjin" "Hebei™ "Shanxi_1" ...
..$ output : num [1, 1:31] 6946 6774 11008 4851 2996 ...
.- attr(*, "dimnames®)=List of 2
..§ 1 chr "GIOV2005"
= ..% : chr [1:31] "Beijing" "Tianjin" "Hebei™ "Shanxi_1" ...
..$ dmunames : Factor w/ 31 levels "Anhui","Beijing",..: 2 28 1@ 24 19 18.
..$ nc_inputs @ NULL
-.% nc_outputs: NULL
121 (Top Level) = R Script = Sod ingurs Nl
Console ~/Desktop/Paper_1/ —[7] Files Plots Packages Help Viewer =M
> data("Economy") © | New Folder | © Delete = Rename = {0 More «
> View(Economy) #2) Home » Desktop - Paper_1 R
> data(“Economylong") Foruusi o i
> View(EconomylLong)
> data_example_1 <- read_malmquist(Economy, -
+ nper=5, i @] .RData 3.6 KB Nov 14, 2018, 4:45 PM
: ::::r:geme"t = Shorizontal, | Rhistory 7.4 KB Nov 14, 2018, 5:18 PM
+ no=1) Coll_Blasco_2006.xlsx 8.4 KB Oct 14, 2018, 2:02 PM
> 9] example_read_data.R 1188 Now 15, 2018, 11:53 AM
9 example_read_data_malmquist.R 2918 Nov 15, 2018, 11:56 AM
% paper_L.Rproj 2058 Nov 15, 2018, 11:51 AM
91 session_LR 47B Nov 1, 2018, 11:26 AM
@] session_2.R 1818 Nov 14, 2018, 4:45 PM

] 72

WAE, FRAMTHEARLE “EconomyLong”

B 52

long format ¥\ H read_malmquist() &%

K 31 BoR VIR ER R AT S deaR

31: long data format #% 31 read_malmquist() & %L

u' RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help ] {‘) = o) 90% @ Juel15nov 11:59 Vicente Q
L XK J ~/Desktop/Paper_1 - RStudio
© -0pler-ld & ~ Addins - # Paper_L ~
2xample_read_data.R* @ | example_read_data_malmquist.R* | EconomyLong Economy 3 w=[7]  Environment History Connections =
SourceonSave | 4 S - +Run | o+ Source ~ ond # Import Dataset + | & List =
1 data("Economy”) % Global Environment ~
2 Vi E
5 "iew( Economy) Datn
4 data("Economylong™) 0 Col1_Blasco_2006 6 obs. of 5 variables
5  View(Economylong) © data_example List of 9
6 . © data_example 1 List of 5
; data_example_1 <- read_malmqulst(i;g:?:y. W data_example 2 List OF
9 arrangement - "horizontal”, O Economy 31 obs. of 16 variables
10 ni=2, 0 EconomyLong 155 obs. of 5 variables
21 no=1)
1z
13 [data_example_Z <- read_malmquist(Economylong,
14 percol=2,
15 arrangement = "vertical",
16 ni=z,
17 no=1)
18
18:1 | (Top Level) R Script
Console ~/Desktop/Paper_1/ =71 Files Plots Packages Help Viewer ]
> data("Economy") @ NewFolder © Delete = Rename | {3 More -
b Vi en Eennomy ) £ Home - Desktop © Paper_1 k
> data("Economylong™) 5
> ViewCEconomyLong) Name Size Modified
> data_example_1 <- read_malmquist(Economy, t.
+ nper=5, @] RData 3.6 KB Nov 14, 2018, 4:45 PM
arrangement = "horizontal", 5
N el g 1 Rhistory 7.4 KB Nov 14, 2018, 5:18 PM
+ no=1) Coll_Blasco_2006.xIsx 8.4 KB QOct 14, 2018, 2:02 PM
> data_example_2 <- read_malmquist(Economylong, @ example_read_data.R 118 B Nov 15, 2018, 11:53 AM
o percol=c, o I d_dat, I R 2918 Nov 15, 2018, 11:56 AM
. arrangenent = "vertical”, example_read_data_malmguist. lov 15, L 11
+ ni=z, i Paper_1.Rproj 205 B Nov 15, 2018, 11:51 AM
+ no=13 9 session_L.R 478 Nov 1, 2018, 11:26 AM
>
97 session_2.R 181 8B Nov 14, 2018, 4:45 PM
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Data Envelopment Analysis with deaR dR

R “example_read_malmquist.R” .

7.2.4. read_data_fuzzy()ER3

W RAEEZ ] fuzzy DEA model AbFAHEHHE (uncertain data) DAIIERCE, HAE
St BAG A read_data_fuzzy() BEEEHHE Ry deaR KRR,

deaR T LLALEERATE (trapezoidal) « XHR =M (symmetric triangular) FIAXTFR =
J& (non-symmetric triangular) FIBORAZL (fuzzy number) (=LK 32) &

32: Fuzzy numbers

Fuzzy numbers

mL mR

Trapezoidal

mL=mR

mL=mR Non-symmetrictriangular

Symmetric triangular dl ‘ d%

L

" R

read_data_fuzzy()BRECR H L NS4
o datadea: ‘& — ML (HLZUE —DEIEHE)
o dmus: DMU JTESII% 5 . BRARE T, deaR 8 DMU B T-HIEHEM 51,
e Inputs.mL: input [¥] mL value (i BT £E KI5 I 2% 5
e Inputs.mR: input X] mR value ¥U{H T 7EF (%% 5
e Inputs.dL: input 1] dL value ${& FTE 5 %% 5
e Inputs.dR: input ] dR value FUH T £E 51 K 4 5
e Outputs.mL: output 1] mL value HUEFT7ERIF )90 5
e Outputs.mR: output ] mR value FUH FT7E5 %% =
e Outputs.dL: output [ dL value H{EFTLES )R 5
e Outputs.dR: output [¥] dR value BUE AT EE S 1490 5
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Data Envelopment Analysis with deaR dR

e nc_inputs: U1 non-controllable inputs (ARJ#EHIAN) , BT EATZH
1

e nc_outputs: WIHRA non-controllable outputs (ANA[=4H) , B[ FHRFEN1E

IR £

e nd_inputs: WA non-discretionary inputs (3F B34k N , AIH TR
IR L

e nd_outputs: WHRA non-discretionary outputs (AEHFfHiH) , afHTFAE
AT A2 W

e ud_inputs: WA undesirable (bad) inputs (ANE/REN) , B[ TR
IR L

e ud_outputs: WA undesirable (bad) outputs (AR /&) , B[ HFHIEA]
SR

HH7, deaR X ft*% & T BCC DEA Model [ fuzzy DEA model 1 f] undesirable
inputs/outputs.

IERARE R 8.

: read_data_fuzzy()ERi £{
1. B — AR, a4 “example_read_data_fuzzy”

PR MR ELKW T TESIEE D, AT IFIHHE “Paper_17, #RJ5 615 Hr
JEAS,  [RIE 7S E %K deaR.

2. INEEARE “Leon2003” 10.
data(“Leon2003”).

ZHPESE (LK 33) A 8 ) DMU. 1 4> symmetric triangular fuzzy input (X
MR=AABRIHIAD  (alpha & input &) F1 1 4> symmetric triangular fuzzy
output (XWFR=MAEMIFIH ) (beta & output NF &)

0 Ledn, T.; Liern, V. Ruiz, J.; Sirvent, |. (2003). "A Possibilistic Programming Approach to the Assessment of
Efficiency with DEA Models", Fuzzy Sets and Systems, 139, 407-419.https://doi.org/10.1016/S0165-
0114(02)00608-5
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Data Envelopment Analysis with deaR

K 33: ##54E Leon2003

@ RStudio File Edit
ene
o -~ = -

“ DMU

A

B u B M AW N R

Filter
x
3.0
40
a5
6.5
7.0
8.0
10.0
6.0

Showing 1 1o 8 of 8 entries

>
>
+
+
+
>
+

> data("Leon2@e3
> View(Leon2083)

Console -

Desk
> View(Economy)

data( "EconomyLong™)
View(EconomyLong)
data_example_1 <- read_malmquist(Economy,

alpha
2.0
0.5
LS
0.5
2.0
05
10
05

¥
3.0
25
6.0
40
5.0
3s
6.0
20

Code View Plots Session

Build Debug Profile Tools
~[Desktop/Paper_1 - RStudio

~ Addins ~

© | example_read_data_maimauistR < €0  example_read_data_fuzzy.R® Econom % o [

beta
1.00
1.00
1.00
125
0.50
0.50
0.50
1.50

nper=5,
arrangement = “herizontal”,
ni=2,
no=1)

data_example_2 <- read_malmquist(EconomyLong,

percol=2,
arrangement = “vertical”,

mi=2

no=1)

=0

Window Help B D = o) 89% M} Juel5nov 12:01 Vicente Q
% paper_1 ~
Environment  History ~ Connections =
- ~ Import Dataset « & List =
& Global Environment ~
Data
© Coll_Blasco_2006 6 obs. of 5 variables
O data_example List of 9
O data_example_1 List of §
0 data_example_2 List of 5
© Economy 31 obs. of 16 voriables
Econom variables
£0n2ee3 8 obs. of 5 va
Files Plots Packages Help  Viewer =
O NewFolder O Delete = Rename b More -
4 Home = Desktop = Paper_1 K
A Name size Modified

t.

@ RData 3.6KB Nov 14, 2018, 4:45 PM
Rhistory 7.4 KB Nov 14, 2018, 5:18 PM
Coll_Blasco_2006. xIsx 8.4 KB Oct 14, 2018, 2:02 PM

@ example_read_data.R 1188 Nov 15, 2018, 11:53 AM

© example_read_data_malmguist.R 5198 Nov 15, 2018, 11:59 AM

& Paper_l.Rproj 2058 Nov 15, 2018, 11:51 AM
@ session_L.R 478 Nov 1, 2018, 11:26 AM
@ session_2.R 1818 Nov 14, 2018, 4:45 PM

3. WAE,

N— S

1&17 rea

d_data_fuzzy() R EH T IHEEHE . vk, AITEATFFHATEL T 44

data_example_3 <- read_data_fuzzy(Leon2003,
inputs.mL=2,
inputs.dL=3,
outputs.mL=4,
outputs.dL=5)

BRI TAE L & DRz LT B (S0 34) -

' 34: {#H read_data_fuzzy() %

RStudio File

‘ece
- o

(]

-

Edit Code View

»

© | example_read_data_malmquist.R

Source on Save

Plots  Session

Build Debug Profile Tools
~[Desktop/Paper_1 - RStudio

- Addins -

© | example_read_data_fuzzy.R
X e

Leon2003

*Run

1 dataC"Leon20@3”)
2 View(Leon2003)
3
4 fdata_example 3 <- read_data_fuzzy(datadea-Leon2003,
5 dnus=1,
6 inputs.mL=2,
7 inputs.dL=3,
8 outputs.mL=4,
9 outputs.dL=5)
10

10:1  (Top Level) =

Consale 'Deskto) 1

+ ni=z,

+ no=1)

> data_example_2 <- read_malmguist(Economylong,

+ percol=2,

+ arrangement = “vertical™,

- ni=2,

+ no=1)

> dato("Leon2003")

> View(Leon2023)

> data_example_3 <- read_dota_fuzzy(dotadea=Leon2ee3,

+ dmus=1,

- inputs.mL=2,

+ inputs.dL=3,

- outputs.ml=4,

+ outputs.dL=5)

>

"~

Economy 3 — [

* Source -

R Scrip

-

Window Help B €O T %) 83%E Juel5nov 12:06 Vicente Q i=
% Paper_l -
Environment  History ~ Connections =i
4 # Import Dataset ~ | & List -
7 Global Environment - a
Data
 Coll_Blasco_2006 6 obs. of 5 variables
D data_example List of 9
O data_example_1 List of 5
of 5
List of 9
obs. of 16 variables
) EconomyLong 155 obs. of 5 variables
D Leonz0@3 8 obs. of 5 variables
Files Plots Packages Help  Viewer -
@ NewFolder @ Delete = Rename {3 More -
4) Home . Desktop = Paper_l 3
& Name Size Modified
@] RData 3.6KB Nov 14, 2018, 4:45 PM
“| .Rhistory 7.4 KB Nov 14, 2018, 5:18 PM
Coll_Blasco_2006.xlsx 8.4 KB Oct 14, 2018, 2:02 PM
@] example_read_data.R 1188 Nov 15, 2018, 11:53 AM
9 example_read_data_malmquist.R 5198 Nov 15, 2018, 11:59 AM
¥ Paper_LRproj 2058 Nov 15, 2018, 11:51 AM
@ session_LR 478 Nov 1, 2018, 11:26 AM
@ session_2.R 1818 Nov 14, 2018, 4:45 PM
@] example_read_data_fuzzy.R 3178 Nov 15, 2018, 12:03 PM
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Data Envelopment Analysis with deaR dR

XA~ F, inputs.dL=alpha Jf H. ouputs.dl=beta. M1 TFHATH symmetric
triangular fuzzy numbers (XIFR=ABKIZL) , BTl inputs.dl=inputs.dR Ff H.
outputs.dL=outputs.dR-

WAE, BANCLEET N R X% “data_example 37 , ‘& EFRATE]
B EIZAT ) fuzzy DEA model 5T % .

7.3. £ B ANIZ1T DEA Model
— B IR T B BN deaR HIATIEASG SN, F— 2 ui &k H DEA Model FHIZ1TE .
TE 4 RTRA ] deaR (A 1.0) 7, ATLLEFILL T DEA model:

Conventional DEA models

Basic (radial) models (envelopment and multiplier forms)
Directional distance function model
(Weighted) Additive model

Super-efficiency additive model

Radial Super-efficiency model

(Weighted) Non-radial model

Preference Structure model

(Weighted) Slack-based model

(Weighted) Super-efficiency slack-based model
Cross-efficiency (crs'! and vrs'?)

Bootstrapping (Simar and Wilson algorithm)
FDH model

Productivity

Malmquist index

Fuzzy DEA models

Kao and Liu model*3

Possibilistic model

Guo and Tanaka model

Fuzzy cross-efficiency* (only crs)

1 ¢rs = constant returns-to-scale. crs =[] & MAHIL . (constant returns-to-scale)
12 yrs = variable returns-to-scale. vrs =28 Zh I 25 (variable returns-to-scale)
13 This Fuzzy DEA model has been extended to a several DEA models. See the help for the package:
help(“modelfuzzy_kaoliu”). Fuzzy DEA model L& #iH R B JL A AE ) DEA model, #1715 1
help(“modelfuzzy_kaoliu”)RE 4K 46175 Bh S & o
14 Based on Guo and Tanaka’s model. 3T Guo and Tanaka’s model
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FE deaR TR, FRATTAT LAER 0 ey i A I Se b R pr B By VEAR U, DLAORT I L6 b
Hof i SR A 2= B o

JLETE deaR W HIRAE T 40 E 31241 DEA model, {HY T HIRFEM AR IEM (GX& deaR
B —NEERE , HPLIE IR 223580 92 it X Lo AR R i AN [6]) 28 4k . 4]
w, S AE “Additive model” HiE M E ARLEE, HAT PLIRAS MPISER AL B RAME
LRI

A=A U EFBAFRBEM R KH T “Preference Structure Model”
(weighted non radial model) [ “#4725#7/% 727 COINMBEAER IR 1 . EXMERT,
F PRI RE “cost Efficiency”  ( “ JEAZCF Y )« “ Revenue Efficiency” ( “ 4
ASCEB ) 8 “Profit Efficiency”  ( “ FIACF A" )

WAE, FATRE WHT{E R model_basic() B 34T basic DEA model:
o FTITIH “Paper_1” , GUE—ANHINA, IHRKHm4 N:  “example_basic” .
o JfN#k deaR
o %% deaR [ BI T TH

i1 model_basic $4% (Z WK 35) . FATHA LAEA RSN T4

help(“model_basic”)

35: model_basic() LRI BIE R

(2] C:/Users/Vicente/Desktop/Paper_1 - RStudio =00 n_
File Edit Code View Plots Session Build Debug Profile Tools Help

0| ejemplo_basicR™ — [~  Environment History Connections -t

: | [JSourceanSave = O A7 i *Run | o SrTEn O 2 [ | [# Import Dataset = = & List ~
1 Tibrary(deaR) 7} Global Environment -

3 Ihe1p (package="deaR") I
4

5 Environment is empt

Files Plots Packages Help Viewer =
&

R: Basic (radial) DEA model, *

~
model_basic {deaR} R Documentation
411 (Top Level) 2 R Saript 3
Console C:/Users/Vicente/Desktop/Paper_1 . _ - =i IBa5|c (radial) DEA model.

Ihe Tollowing objects are masked Trom “package:stats’: ~
filter, lag Description

The following objects are masked from ‘package:base’: Solve input and output oriented basic DEA models (envelopment form) under
i i i constant (CCR DEA model), variable (BCC DEA model), non-increasing, non-
intersect, setdiff, setequal, union decreasing or generalized returns to scale. By default, models are solved in a

two-stage process (DEA slacks are maximized).
warning message:
package ‘dplyr’ was built under R version 3.4.4 The model_basic function allows to treat with non-discretional, uncontrollable and
> help(package="deaR") undesirable inputs/outputs
>

v < >

15 Measure of Inefficiency Proportions (MPI)
16 Range Adjusted Measure (RAM).
29
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Data Envelopment Analysis with deaR dR

model basic()BRECKH L NS4

datadea: ‘&2 — AR (HOBAHE— AN EIEHED

dmu_ref: E#E DMU 114

dmu_eval: \TEEH IR B R; VA ) DMU

orientation: DEA model BJXE\I/E 7] (orientation) :input-oriented, output-
oriented 33 direccional

dir_input: TEATEIEREY (directional models) H input A5 A% E (direction

vector)

dir_output: TEAEIFEREY (directional models) A output AJAMEI&E (direction

vector)

rts: FEUZS (Returns to scale) [BIEEE (constant) RIS, A58
(variable) FEUZES, FEIHHE (non-increasing) AMEULZS. FEIBR (non-

decreasing) AR EBM (generalized) s ZE]

L: %% generalized rts i, lower bound.

U: %% generalized rts 5/, upper bound.

Maxslack: BRINKB T, slack 2{HEE ZMERA1L

weight_slack_i: F3 F AT LA7E S5 — [TER NGB input slack FURELUEH SR AL

weight_slack_o: FAFRJLATESE _MERIRE output slack AUNELAEESLIR KX

e

vtrans_i: 5t %A B i\ (undesirable inputs) FIAZZNHIAEW S (variable returns-
to-scale) , H [ LLE P &&E (translationvector) . BRIAKE , PR

B A (max + 1)

vtrans_o: X RB%iE (undesirable outputs) FIAZSPHEIL2E (variable
returns-to-scale, FAJTRILIIXB B KE (translation vector) » BRKIANIKE T, F
%8 Mmax + 1),

compute_targets: 1155 K slack fig 77 1) H bx
compute_multiplier: % 7] multiplier form f3fe% (BiAE)

returnip: EIXE— DMU, HhB#OREZE 5 — A9 26 [F]@H (linear problem )

30
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Wiz, BAWS@EILRG 9 FRAI 10 22 SJIAIER model_basic() B, B%, HiTE
£ deaR P HNZEEIBE "PFT1981"Y, IXNEIEETR 70 D DMU (school site) , 5 input

(Education, Occupation, Parental, Counseling, Teachers) 1 3 4 output (Reading, Math,
Coopersmith) . T (K 36) R 7 AMMBIZEIE A TE A" example_basic" B
ABFED,

36: dE4E PTF1981

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help B DO = o) 72% @)} Viel6nov 12:07 Vicente Q =
[ XoN ] ~{Desktop/Paper_1 - RStudio
e - Cx - ~ Addins ~ K Paper_l ~
@ | example_basic.R* [  Environment History Connections ()
Filter = # Import Dataset = = & List ~
“ site Education  Occupation Parental Counse ling ~ Teachers Reading Math € T Global Environment -
1 Sitel 86.13 16.24 48.21 49.69 9 5453 58.98 Datg,
2 Site2 29.26 10.24 41.96 40.65 H 2469 3389 c PFT1981 7@ obs. of 10 Vﬂ”‘ﬂme>5
3 Site3 43.12 1131 38.19 35.03 E] 3641 40.62
4 Sited 24.96 6.14 24.81 25.15 2 1494 17.58
5 SiteS 1162 2.21 6.85 6.37 4 7.81 6.94
6 Site6 11.88 497 18.73 18.04 4 1259 16.85
7 site7 32.64 6.88 28.10 25.45 7 17.06  16.99
B Sited 20.79 12.97 54.85 52.07 8 2019 30.64 Files Plots Packages Help Viewer =0
9 Sited 34.40 11.04 38.16 42.40 8 2613 29.80 o
10 Sitel0 61.74 14.50 43.09 42.92 9 46.42 51.59 R: Basic (radial) DEA model. ~
11 Sitell 52.92 1167 39.48 39.64 5 39.80  372.73 model_basic {deaR}) R Documentation
12 Sitel2 36.00 10.15 37.80 39.52 5 37.84  47.85
13 Sitel3 39.20 10.80 41.04 4112 7

648 3136 Basic (radial) DEA model.

Showing 1 to 14 of 70 entries

Description
Console ~/Deskt =0 : :
Solve input and output oriented basic DEA models (envelopment form) under constant (CCR
DEA madel), variable (BCC DEA model), non-increasing, non-decreasing or generalized returns
filter, lag to scale. By default, models are solved in a two-stage process (DEA slacks are maximized).
The following objects are masked from ‘package:base’: The model_basic function allows to treat with di ional, ul and undesirabl
inputsioutputs.
B kT ., Finally, you can use the model_basic function to solve directional DEA models by cheosing
> help(package="deaR") orientation ='dir".
> data("PFT1981") '
> View(PFT1981) Usage

model basic(datadea,
dmu_ref = NULL,
dmu_eval = NULL,
orientation = c("ic", "oo", "dir"),
dir_input = NULL,
dir_output = NULL,

: model_basic() &k

£ “PTF1981” 1170 /> DMU ', H 49 AT Project Follow Through (PFT), 21 M
Non-Follow Through (NFT).

EXA R, FAEH input-oriented CCR DEA moldel 3Kt PFT H1f¢) 49 4~ DMU )
Ve

B, FATIEH read_data() R EHEEIE AN deaR R[N (L 7.22 7)) . &
o PR PATFE S

PRk, i model_basic() %, FIAFRA A E@EEH CCR DEA model ('E—14
conventional DEA model) KIELE PFT ] 49 4> DMU FIRCER, Nk, FAMER S5
dmu_ref=1:49; WIRZEPEAL A AL Cunits) Wﬁ%?ﬁ;‘ﬁ dmu_eval=1:49. Hitt,
II{EIIA “example_basic” H 5 NFFHATLL 484 (LK 37)

17 Charnes, A.; Cooper, W.W.; Rhodes, E. (1981). "Evaluating Program and Managerial Efficiency: An Application
of Data Envelopment Analysis to Program Follow Through", Management Science, 27(6), 668-697.
https://pubsonline.informs.org/doi/abs/10.1287/mnsc.27.6.668

31
©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)



Data Envelopment Analysis with deaR

result_pft <- model_basci(PFT1981,

dmu_ref=1:49,
dmu_eval=1:49,
orientation="io”,
rts="crs”)

. AT LB KIZATIRS, WAl blaik)s s el

37: IZT input-oriented CCR DEA model il & PFT #1f¢) DMU

". RStudio File Edit Code View Plots Session Build Debug Profile Tools

Q@ -oR e } ~ Addins

@] example_basic.R*
Source on Save | (4~

2
3 help(package="deaR")
4

5 data("PFT1981")

6 View(PFT1381)

7
8

9 # Adapting the data to the reading format
1@ data_basic <- read_data(PFT1981,

11 dmus=1,
12 inputs=2:6,
13 outputs=7:9)

result_pft <- model_basic(data_basic,

17 dmu_eval=1:49,

18 dmu_ref=1:49,

19 orientation="io",
20 rts="crs")

21 %

22

211 | (Top Level)

Cansole ~/Desktop/Paper_1/
> help(package="deaR")
> data("PFT1981")
> View(PFT1981)
> # Adapting the data to the reading format
> data_basic <- read_data(PFT1981,
dmus=1,
inputs=2:6,
outputs=7:9)
# Running the input-oriented CCR DEA model
result_pft <- model_basic(data_basic,
dmu_eval=1:49,
dmu_ref=1:49,
orientation="io",
rts="crs")

AR R

+Run

o

~/Deskiop/Paper_1 - RStudio

=0

Source

R Script

=0

Window Help & 9 = o) 72%@) Vie16nov 12:09 Vicente Q =
% Paper_1 -
Environment  History ~ Connections =
el # Import Dataset = | & List =
7} Global Environment ~
Data
0 data_basic List of 9
28 2 of 10 variables
Files Plots Packages Help Viewer =

)

R: Basic (radial) DEA model. =

model_basic {deaR} R Documentation

Basic (radial) DEA model.

Description

Solve input and output oriented basic DEA models (envelopment form) under constant (CCR
DEA model), variable (BCC DEA model), non-increasing, non-decreasing or generalized returns
to scale. By default, models are solved in a two-stage process (DEA slacks are maximized).

The model_basic function allows to treat with non-discretional, uncontrollable and undesirable
inputs/outputs.

Finally, you can use the mode1_basic function to solve directional DEA models by choosing
orientation ='dir".

Usage

model_basic(datadea,
dmu_ref = NULL,
dmu_eval = NULL,
orientation = c("io", "eo", "dir"),
dir_input = NULL,
dir_output = NULL,

model_basic() &%

PILE, YRATLLIEIEIER CCR input-oriented DEA model &iHE4A7F NFT 51/ DMU %K
N2 (NFT H1f) EMU HE51 T 50-70)

A

RSt P (W 38)
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38:

Data Envelopment Analysis with deaR

i&4T input-oriented CCR DEA model Jll & NFT H1f£) DMU

# RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help B 9 = W) 7% Viel6nov 12110 Vicente Q
ece ~[Desktop/Paper_1 - RStudio
O -| 0 |2 - 3 - Addins - # paper_1 -
@ example_basic.R* ("]  Environment History Connections =M
Source on Save | S *Run | "% Source - “ # Import Dataset + | & List -
9 ¥ Adapting the data to the reading format 1 ‘Global Environment ~
10 data_basic <- read_data(PFT1981,
Data
11 dmus=1,
12 inputs-2:6, O data_basic List of 9
13 outputs=7:9) gf 10 variables
14
15 # Running the input-oriented CCR DEA model
16 result_pft <- model_basic(data_basic,
17 dmu_eval=1:49,
18 dmu_ref=1:49
19 orientation="io",
20 rts="crs") Files Plots Packages Help  Viewer =M
21 hte in o
22 fresult_nft <- model_basic(data_basic,
23 dmu_eval=50:70 R: Basic (radial) DEA model. =
& it model_basic {deaR} A Documentation
25 orientation="io",
26 rts="crs") . 3
27 Basic (radial) DEA model.
28
29 ..
271 | (Top Level) = Rscip - DeSCription
Console ~/Desktop/Paper_1 [  Solve input and output oriented basic DEA models (envelnpmem farm) under constant (CCR
- - d returns

# Rul
resu

# Ru
resu

T 2 2R T Tk S SRR

nning the input-oriented CCR DEA model

1t_pft <- model_basic(data_basic,
dmu_eval=1:49,
dmu_ref=1:49,
orientation="io",
rts="crs")

nnig hte input-oriented CCR DEA model for DMUs in NFT.

lt_nft <- model_basic(data_basic,
dmu_eval=5@:7@,
dmu_ref=50:70,
orientation="i0"
rts="crs")

DEA model), variable (BCC DEA model), n
to scale. By default, models are selved in a two-stage ufocess (DEA s\acks are maximized).

The model_basic function allows to treat with non-discretional, uncontrollable and undesirable
inputsfoutputs.

Finally, you can use the mode1_bas ic function to solve directional DEA models by cheosing
orientation ="dir".

Usage
model basic(datadea,
dmu_ref = NULL,
dmu_eval = NULL,
orientation = ¢("io", "eo", "dir"),
dir_input = NULL,
dir_output = NULL,

PREHZA “example_basic”
7.4 B EELER

fEﬁ%WU9 FRB] 10 H1, IE4T model basic() B2 5, ﬁﬁ%?E@%%ﬁ%%ﬁﬂﬁﬁ?%ﬂﬁ%??%EXiﬁi

“result_pft” 1 “result_nft” . WLAER], XN REZ S AEFE 11 DA
IR, AT LB B R AFR (S E 39) REFEGANVIRMANE, HalblE
TR EEAT LB @) KREEMAIMLS

&l 39: basic DEA model 145 5 2 H 454

@ Rstudio File Edit Code View Plots Session Build Debug Profile Tools Window Help B ‘D = o) 71%@) Vie16nov 12111 Vicente Q
oce ~/Desktop/Paper_1 - RStudio
o | Og > - H ~ Addins ~ ® Paper_1 -
© | example_basic.R* ~[7]  Environment History Connections =z
Show Attributes. o # Import Dataset - | & List =
Name Type Value 7} Global Environment ~
© result_nft list [11] (53: dea) List of length 11 Data
modelname character [1] ‘basic' © data_basic List of 9
orientation character [1] Yo" ) PFT1981 70 obs. of 1@ variables
s character (1] s’ result_nft List of 11
L double [1] 1 O result_pft List of 11
u double [1] u
DMU list [21] List of length 21
data list [9] (53: deadata) List of length & Files Plots Packages Help Viewer =0
dmu_eval integer [21] 5051 52535455... o
dmu_ref integer [21] 505152535455 ... e I N mod e
vtrans_i NULL Pairlist of length 0 model_basic {deaR} R Documentation
vIrans_o NULL Pairlist of length 0
Basic (radial) DEA model.
(No selection) Description
Console ~/Desktop/Paper_1 — [  Solve input and output oriented basic DEA qusis {epve\c:‘pnr:snl fmm) under cunst%nl (Crgtlzms

DEA model), variable (BCC DEA model), ne
+ outputs=7:9) to scale. By default, models are solved in a two-stage process (DEA slacks are maximized).
> # Running the input-oriented CCR DEA model

> result_pft <- model_basic(data_basic, The model_basic function allows to treat with non-diseretional, uncontrollable and undesirable

+ dmu_eval=1:49, inputs/outputs.

* dmu,r'ef=1:4?: 2 Finally, you can use the model_basic function to solve directional DEA models by choosing
* orrantations 10y orientation ="dir",

+ rts="crs")

> # Runnig hte input-oriented CCR DEA model for DMUs in NFT. Usage

> result_nft <- model_basic(data_basic,

+ dmu_eval=50:7@, model_basic(datadea,

+ dmu_ref=50:70, dmu_ref = NULL,

+ orientation="io", dmu_eval = NULL,

i rts="crs") orientation = o{"io", "eo", "dir"),
> View(result_nft) dir dnpot. S NULL,

. dir output = NULL,
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dR

deaR H A JULAREE M BREH TR GE2$EH) DEA i Eah B, IX SR B2
v efficiencies(): J2HUKZ 534 (efficiency score)

NN

slacks(): F£HL input F1 output [ slack #{E

targets(): F2HL input Ml output ] HA#{H (target value)
lambdas(): $2H lambda £ [803#Z Cintensity) ]
references(): $EHUILZL DMU 1S %4 (reference set)
rts(): FEIMMAEIL S (returns-to-scale)

v multipliers(): #2H{ multiplier DEA form 1 [{13e % (BiALE)
TEE N R RG] 11 H, AL S X e ek

5l 11O

B “result_pft” THEERER D E (efficiency score) , AR FEA G 5 N IFEHAT

LR R4

efficiencies(result_pft)

gk B4 2 B ORTE Console THIMR A, W N EFT~:

& 40: PFT H1{#) DMU FIRCE 431

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help B 4D = o) 70% @)} Vie16nov 1213 Vicente Q =
[ ] (] ~[Desktop/Paper_1 - RStudio
o | odid - Addins = E Paper_l -
© | example_basic.R* Environment  History ~ Connections =0
Source onSave | O /- +Run | =+ Source - g ~ Import Dataset - & List +
13 orientation="io", % Global Environment =
20 rts="crs") Data
21 # Runnig hte input-oriented CCR DEA model for DMUs in NFT. ) "
22 result_nft <- model_basic(data_basic, data_basic List of 3
23 dmu_eval=50:7@, PFT1981 70 obs. of 10 variables
24 dnu_ref-50:72, ) result_nft List of 11
25 orientation="i0", =
2 ts="crs™ result_pft List of 11
27 # Ejecutamos el modelo CCR input-orientade para DMUs en NFT.
28 result_nft <- model_basic(data_basic,
29 dmu_eval=50:7@,
30 dmu_ref=50:70, Files Plots Packages Help Viewer -
31 orientation="i0", @
32 rts="crs")
33 R: Basic (radial) DEA model. ~
a8 = “ — gy scores model_basic {deaR} R Documentation
35 Jefficiencies(result_pft)
36
37 Basic (radial) DEA model.
38
39 i
Description

36:1 (Top Level) =

> # Extracting the efficiency scores

> efficiencies(result_pft)

Sitel Site2 Site3 Site4 Site5 Site6 Site?7 SiteB Sited Sitele
1.00000 ©.99169 ©.98827 ©.90244 1.00000 ©.90689 ©.89236 0.91476 ©.871@3 1.00000
Sitell Sitel2 Sitel3 Sitel4 Sitel5 Sitelé Sitel? Siteld S5itel? Sitez@
©.98194 @.97444 ©.85996 ©.98397 1.00000 ©.95030 1.00000 1.00000 ©.95010 1.00000
Site2l Site22 Site23 Site24 Site25 Site26 Site27 SiteZ8 S5itezd S5ite30
1.00000 1.00000 ©.9630@ 1.00000 ©.97644 ©.93714 1.00000 ©.94433 @.84171 0.90255
Site31 Site32 Site33 Site34 Site35 Site36 Site3d7 Site38 Site39 Sitedd
©.83922 ©.90698 ©.24022 ©.85206 1.00000 @.830318 @.86141 ©.97@15 ©.93515 1.00000
Site4l Sited2 Sited3 Sited4 Sited5 Sitedb Sited? SitedB Sitedd
B.94682 ©.94735 0.87076 1.00000 ©.89159 ©.99873 1.0000¢0 1.00000 1.00080

>

>

Solve input and output oriented basic DEA models (envelopment form) under constant (CCR
DEA model), variable (BCC DEA model}, non-increasing, non-decreasing or generalized returns
to scale. By default, models are solved in a two-stage process (DEA slacks are maximized).

The model_basic function allows fe treat with non-discretional, uncontrollable and undesirable
inputs/outputs.

Finally, you can use the model_basic function to solve directional DEA models by cheosing
orientation ="dir".

Usage

model basic(datadea,
u_ref = NULL,
dmu_eval = NULL,
orientation = c("io", "eo", "dir"),
dir_input = NULL,
dir_output = NULL,

[FIFEH, ZZIRIKAL DMU IZHE4E (reference set) , FATEAIHFHATUL T HE L

references(result_pft)

34
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H AR (slacks() BRI %L. targets()BREL. lambdas()ER %L, rts() R multipliers() BREAR LA
A Rz tr . B EIRGR I X ek 5, FFOTFEIRIRIF I EE R

7.5. R summary()

B 7 ESCHBSHI R (AN efficiencies()s lambdas()35) #4b, deaR i summary() &%,
FFIC R DEA M ailss B, BFRFIEH T conventional DEA model Al fuzzy DEA
model N RIS . B ZRE, RATHFE 1 E B LLUF 4.

summary(objet, exportExcel = TRUE, filename = NULL)
HEANSHA RN

o object: XI&R, FATHE AL T conventional DEA model Y, fuzzy DEA model [543 #7
iR
o exportExcel: ZIS K ER A A TRUE, ETFItk, summary() RIS S B 3IREL/E
BERXTERBETELRN Excel X, APt A LUEFERE B Excel X
(exportExcel = FALSE)
o filename: ZINSHEERLINME N NULL, 25T, AR Excel SCHFIBRINBFR N
“ ResutsDEAyear-month-dat_hour:minute:secondxlsx” - 44X, B/ alg
5 Excel X180
IEANETTEIHE RN, 7E conventional DEA model 1 fuzzy DEA model H1iz H summary() & %L
{8k DEA Zr i & BRI 7 VA AR R, H 22 5] DLTE R B0 ) Excel SCHFHRERE], R
POV Excel TAER SR HTE R ARG BT 250 . ARG 12 FRp] 13
B BEANSE.

: conventional DEA model

T MR B THI A 25 3R
1. ¥TFF B “Paper 1"
2. B —NERBIA © “Summary_DEA"
3. hN% dear

BRig : h0%K deaR 1EEMEIERE "Hua Bian 2007"Y°, IX N IBER 30 4 DMU, 2 M

input (D-Input1, D-Input2) , 2 > output (D-Outputl, D-Output2) F1 1 /) undesirable
output (UD-Output1) CHAEFIGT 5K R B BF—20

18 For more details: help(summary.dea) o help(summary.dea_fuzzy).
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HAEEEM output-oriented BBC DEA model HIREAERIC M, AT IZEEFEE 1 D
undesirable output, NTIEDHTHIBEEERH, A ¥EMA Hua and Bian (2007)%
B FE#BS2L (translation parameter) : vtrans_0=1500

FEEE: FIILMEH dear KPR
R 1. s

R 2. IRYE deaR {3 HUMS 70 B AR
!
[

N

/

NG
§

N
B

3. 1547 DEA model
4, Feiugs R

\F
%2

MrEstutate 11

(BRRRET

¥ Hua Z.; Bian Y. (2007). DEA with Undesirable Factors. In: Zhu J., Cook W.D. (eds) Modeling Data Irregularities

and Structural Complexities in Data Envelopment Analysis. Springer, Boston, MA. https://doi.org/10.1007/978-
0-387-71607-7 6
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ZR: EWMRAER 41 hERNK, E@Ekonf 12 KR8, AT ZEAL R A
“Summary_DEA” HRKIRE NI N84

IR 1 mEE -
data(“Hua_Bian_2007")
IR 2. VB
data_example_12 <- read_data(Hua_Bian_2007,
ni=2,

no=3,
ud_output=3)

®R: A 3 output (no=3) , HH% 3 4~/ undesirable output
(ud_output=3)

0% 3. i51T DEA model:

result_example_12 <- model_basic(data_example_12,
orientation="00",
rts="vrs”,
vtrans_o= 1500)

41: B 12 R

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ 4D = W) 100% B Sib17 nov 13:07 Vicente Q =
[ ] & ~/Deskiop/Paper_1 - RStudio
e - Oy >~ - Addins - K Paper 1 -
[  Environment History Connections =0
Source onSave | 4 - +Run | % Source - " i # Import Dataset ~ & List ~
1 library(deaR) "% Global Environment +
2
3 | # STEP 1. LOADING DATA: bata
4 | data( "Hua_Bian_z007") 0 data_example_12 List of 9
= Hua_Bian_2@87 3@ obs. of 6 variables
6 | # STEP Z: ADAPTING THE DATA: result_example_12 List of 11
7 | data_example_12 <- read_data(Hua_Bian_20€7,
8 ni=2,
9 no=3,
10 ud_output=3)
alsk
12 || # STEP 3: RUNNING THE DEA MODEL: Files  Plots Packages Help Viewer =
13 § result_example_12 <- model_basic(data_example_12, © ) NewFolder | © Delete = Rename {3 More ~
14 orientation="o00", & = R = i 'S
15 rts—"vrs", > Home esktop aper_!
16 vtrans_o— 1500) A Name Size Modified
17 L.
13 @) Rpata 8.3KB Nov 15, 2018, 6:20 PM
“ .Rhistory 8.6 KB Nov 17, 2018, 1:03 PM
18:1  (Top Level) = R Script =
Coll_Blasco_2006.xlsx 8.4 KB Oct 14, 2018, 2:02 PM
Conen ke  ankto PP 1 _ =0 @ example_basic.R 1.1 KB Nov 16, 2018, 12:14 PM
Zemiboraty(dedR) @ example_read_data.R 1198 Nov 15, 2018, 6:20 PM
i B e e e I dl_data_f R 317B Nov 15, 2018, 12:03 PM
> dataC"Hua_Bian_z0a7") example_read_data_fuzzy. jov 15, . 12
> # STEP Z: ADAPTING THE DATA: @ example_read_data_malmquist.R 519 B Nov 15, 2018, 11:59 AM
> data_example_12 <- read_data(Hua_Bian_2007, ® Paper_1.Rproj 2058 Nov 17, 2018, 1:04 PM
+ ni=2, )
b no=3 @ session_LR 47 B Nov 1, 2018, 11:26 AM
+ ud_output=3) @ session_2.R 1818B Nov 14, 2018, 4:45 PM
> # STEP 3: RUNNING THE DEA MODEL: @) Summary_DEA.R 663 B Nov 17, 2018, 1:06 PM
> result_example_12 <- model_basic(data_example_12,
+ orientation="co"
+ rts="vrs",
+ vtrans_o= 1500)

WZE, PTG 2T output-oriented BCC DEA model FAE T #5451 45 S35 v LAZEXT %
“result_example_12”7 W F|, X2—MUET 11 MARYIER (Z0E 42) .
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42:

“result_example_12" H45E¥

o RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help G = o) WO%EE S4b17nov 13:08 Vicante Q =
ace ~/Desktop/Paper_1 - RStudio
O - Ol - - Adding = K Paper_] -
| Summary_DEAR" [T Environment History Conmections -
] scurcecnsave O, - +Run | - Source - = = impart Dataset - | & List -

1 library(deaR) i Global Environment =

z

3 # STEP 1. LOADING DATA: L=

4 dotal ten_Blon_2007°) O dato_exomple_12 List of 3

H o £ § variables

6 # STEP 2: ADAPTING THE DATA: result_exomple_12 List of 11

7 dato_exomple_ 12 <- read_datoHua_Bien_2007, BT G T LT

i ni-2, - ”.'_ e Teeae

3 -3, orientation: chr "oo

10 wd_cutput-3) rts 1 chr “vrs'

n L:rml

12 & STEP 3: RUNNING THE DEA MODEL U:oml

13 result_example 12 <- model_basic(data_example_ 12, oMU List of 3@

= ki Gy ..5 DMUL :List of &

15 rts="vrs",

1% vErans_o- 15007 oo ..§ efficiency @ rum 1

17 .. .. lombda : Nomed rum [1:30] 1000000000 ...

18 ve ee o.m GtRR(t, “nomes®)s chr [1:30] “OMUL" "DMUZ™ "DMU3" DA™ ..

.. .5 slack_input : Named num [1:2] @ @

18:1  (Tep Level = R Serign = ve aa a.- GREP(Y, “nomes®)- chr [1:2] “D-Inputl” "O-Inputl”

Console -/ DeskiopPape - Files  Flots  Packages  Help  Viewer —im
= librory{dech) T wew Folder | @ Delete o Rename O More -
> # STEP 1. LOADING DATA: A Home - Deskiop - Paper_L L
= dato{ "Huo Bion 2097") & N, L
» # STEP 2: ADAPTING THE DATA: L S Mockled
» doto_exomple 12 «<- reod_doto(Huo Bion 2087, t.
. ni=2, B RData 8.3 KB Now 15, 2018, 6:20 PM
. no=3,
- vd_outputed -Rhistory BEKE Nov 17, 2018, 1:03 PM
» # STEP 3: RUMNING THE DEA MODEL: Coll_Blasco_2006. xksx BAKE Ot 14, 2018, 2:02 PM
» result_exomple 12 «- model_bosic(doto_exomple 12, 9 example_basic.R 11KB Nov 16, 2018, 12:14 PM
. ::“"::::m' o 9 example_read_dara R 198 Nov 15, 2018, 6:20 PM
. wtrons_os 15980 9 example_read_dara_fuzzy.R nre Now 15, 2018, 12:03 PM
* @) example_read_data_malmauist.i 5198 Nov 15, 2018, 11:59 AM
B
. B Paper_L.Rproj 2058 Now 17, 2018, 1:04 PM
> @ session_LR 478 Nov 1, 2018, 11:26 AM

FXE, FRATFIE 1 W@ A R4 efficiencies()s lambdas()«
references(). slacks(). targets()F&HUMTHIE 0 4558, LA Wil Af F BR 2 summary()

oM 45 BIC AL
un

multipliers()~ rts()-

T

2

43 iin, TAMER efficiencies()ERERIZEL DMU R4 31 Cefficiency score)

RZ (efficiency) fE Console FH W D ALLAE X R “eff” . #E3K13 M Hua and Bian
(2007)W FE FIAE I EE R, FRATERIA 5 AN IFHAT LA 54

43: JCEIE

1/eff

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ <O = W) 100% @ S&b17nov 13:14 Vicente Q =
[ RoN ) ~/Desktop/Paper_1 - RStudio
Qo -0 & - } ~ Addins - R paper_L -
© summary_DEAR* [ Environment History ~Connections =0
Source onSave = O /- +Run | Source - | = - # Import Dataset = | & List
3 # STEP 1. LOADING DATA: "k Global Environment =
; data( "Hua_Bian_2007") Data
6 # STEP 2: ADAPTING THE DATA: oc List of 11
7 data_example_12 <- read_data(Hua_Bian_2007, © data_example_12 List of 9
8 ni-2, © Hua_Bian_zee7 3@ obs. of 6 variables
l: D‘:ol’:tputﬁ) © result_example_12  List of 11
1 2
—
12 # STEP 3: RUNNING THE DEA MODEL: | Named num [1:30] 111.18 1.7 1 ...]
13 result_example_12 <- model_basic(data_example_12,
14 orientation="c0",
15 rts="vrs",
16 vtrans_o= 1500
oh il I Ka y i
18 |# STEP 4. EXTRACTING (PARTIAL) RESULTS: Flles [ 7300 | skt | el [ e =0
19 Jeff <- efficiencies(result_example_12) @ NewFolder | © Delete =|Rename | {JF More ~
20 #2) Home * Deskiop  Paper_l S
?} # reuslt M5 in table 6-5 (p. 119) vy Size Modified
17:1 5 R Seript 3 t
Console /Deskiop/Paper 1/ =0 @) RData 83kK8 Nov 15, 2018, 6:20 PM
> eff ] Rhistory 86K8 Nov 17, 2018, 1:03 PM
DMUL  DMUZ  DMU3  DMU4  DMUS  DMUG  DMU7  DMUB  DMUS  DMUl®
Coll_Blasco_2006.xl: 84K8 Oct 14, 2018, 2:02 PM
1.08000 1.00800 1.17726 1.06856 1.00000 1.80000 1.81357 1.25406 1.56036 1.00000 ol G
DMU11 OMU1Z DMU13 OMU14 DMUIS DMU16 DMUL7 DMUL8 DMUL9  DMU2@ @ example_basic.R L1K8 Nov 16, 2018, 12:14 PM
1.25912 1.00008 1.00274 1.00008 1.060000 1.85934 1.00000 1.65749 1.62927 1.00000 O] axample_read dataR 1198 Now 15, 2018, 6:20 PM
DMUZ1  OMU2Z  DMUZ3  DMUZ24 [DMUZ5 DMU26 OMUZ7 OMU28  DMUZ9  DMU3@
o 4
1.14440 1.00000 1.00000 2.17814 1.26370 180000 1.00000 1.00798 1.00000 1.00000 f example_read_data fuzzy.R ATap R A
> 1/eF # reuslt M5 in table 6-5 (p. 119) @ example_read_data_malmquist.R 5198 Nowv 15, 2018, 11:58 AM
DMUS DMUG DMUB ® Ppaper_1.Rproj 205 B Nov 17, 2018, 1:04 PM
1.0000000 1.9000000 ©.8494300 ©.9358383 1.8000800 1.0806000 0.9866117 0.7974100 - i g A
oMUg DMULe oMLl oMU12 oMU13 DMUL4 DMULS oMULe e O i
©.6408777 1.0090000 0.7942055 1.0000000 ©.9972675 1.0000000 1.0000000 ©.9434496 @ session_2.R 1818 Now 14, 2018, 4:45 PM
oMUL7 oMU18 oMU1e DMUZ@ oMUZ1 DMUZ2 oMUZ3 DMUZ4 @) Summary DEAR 657 8 Now 17, 2018, 1:12 PM
1.0000000 @.9456354 0.6137718 1.0000000 0.8738203 1.0000000 1.0030020 0.4698939 N
oMUZS oMUZ6 oMuz? DMUZ8 DMUZ9 oMU38
©.7313271 1.0000000 1.0000000 ©.9920832 1.6000000 1.0000000

>
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FEIRAVIL T output-oriented BCC DEA model {145 RICa, FRAMER summary() k%, 7
JHAS “Summary DEA” H5 NLL N4

summary(result_example_12)

ATULEE], I S REAE Console TR S 1 k. REBAZ /> DMU CLIREE]
T30 ), HERARZ . Ji5h, BEIBAT summary() R EUR B R L ARG
ZE R RVE AV R . IEWMIRAIER 44 HEBIFIIEE, deaR e HBEMK—
BE T IAERE Excel M. EER, BUANRE T2 RS TSES 2 1.

44: TR 12 FEE R

[ 3 i File Edit Code View Plots Session Build Debug Profile Tools Window Help B 0 = o)) 100% @@ S&b17 nov 13:15 Vicente CIg=
[ ] & ~/Deskiop/Paper_1 - RStudio
e - Oy >~ - Addins - K Paper 1 -
@ | summary_DEA.R* [  Environment History Connections i)
Source onSave | 4 - +Run | % Source - " i # Import Dataset ~ & List ~
s T niszy "k Global Environment ~
9 no=3, Data
ﬁ e_output=3) Oc List of 11
12 # STEP 3: RUNNING THE DEA MODEL: data_example_12 List of 9
13 result_example_12 <- model_basic(data_example_12, Hua_Bilan_20@7 3@ obs. of 6 variables
14 orientation="00", O result_example_12  List of 11
i-; ﬁ:r.:rz: : 1502) Yalies
17 i eff Named num [1:36] 1 1 1.18 1.87 1 ...

18 # STEP 4. EXTRACTING (PARTIAL) RESULTS:
19 eff <- efficiencies(result_example_12)

20 eff

21 1/eff # reuslt M5 in table 6-5 (p. 119)

2z Files Plots Packages Help Viewer -
23 J# SUMMARY OF RESULTS =

24 ©  NewFolder © Delete - Rename {J More ~

25 [summary(result_example_12) /A Home © Desktop - Paper_1 3

26 A Name Size Modified

26:1 | (Top Level) = R Script = t .

Console . /De Paper 1/ = @ .RData 8.3 KB Nov 15, 2018, 6:20 PM
° bR e Bid i * .Rhistory 8.6 K8 Nov 17, 2018, 1:03 PM
7 0.0002 0. 0000 0.0000 0.9578
8 2.0000 0. 0000 0.2000 2.0696 Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
9 ©9.0455 0.0000 0.0200 ©.0000 @] example_basic.R 1.1KB Nov 16, 2018, 12:14 PM
1@ ©0.0000 0. 0000 0.0000 ©0.9000

@ 3

1 2. 0000 0. 2000 2.0000 0.0722 example_read_data.R 119 B Nov 15, 2018, 6:20 PM
12 0.0000 ?.0000 0.0000 ©.0000 @ example_read_data_fuzzy.R 317 B Nov 15, 2018, 12:03 PM
13 ©.2558 ©.0000 ©.0000 ©.0000 @ example_read_data_malmaquist.R 519 B Nov 15, 2018, 11:59 AM
14 0.0000 0.0000 0.0000 0.9000

R j i

15 2.0000 0. 0000 .0000 2.0000 Paper_1.Rproj 205 8B Nowv 17, 2018, 1:04 PM
16 8.0000 0.0000 ©.0000 2.0000 @] session_L.R 47 B Nov 1, 2018, 11:26 AM
17 0 .0000 0. 0000 08000 ©.0000 9 session_2.R 181 B Nov 14, 2018, 4:45 PM

reached getoetiuns "max.print") -- omitted 13 rows ] & s PEAR sir .
Warning message: CUlCIVR - ol .
In rtsobject) : I ResultsDEA2018-11-17_13:15:07.xIsx I 14.9 KB Nov 17, 2018, 1:15 PM

rts function with variable returns teo scale does not make much sense!
>

BATIF Excel XM REBBTE LR (LK 45) , EHRE XM “ResutsDEAyear-month-
dat_hour:minute:second.xlsx” FFiEFE “View file” 1EITRIT]
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44: Excel XAFFHIIC MEE

@ Excel Archivo EdiciSn Ver Insertar Formato Herragai Doz B torine 22 [h *’D = o) 100% B Sab17 nov 12:48 Vicente Q =
eooe I [® ResultsDEA2018-11-17_12/35/11.xlsx (Sdlo \ectura)l
PECRA® XD B 9 0 Z-% F @0 6 o @ @ )
| # micio | Disefio | Tablas | Grificos | SmartArt | Férmulas | Datos | Revisar | [~ 2
Editar Fuente Alineaci Ndmera Formato Celdas. H Temas
=2 . [#] retlenar +  [catiori (Cuerpo) [+[11 [+]|Ax | A-| || = = BB |abe | S0 Austar texto ~ | [General = 5 %ﬂi. &:ﬂ. . i [aay. B
: e S ® i
pogar (A Borrar ~ @ Cl S| i [S[]1ATL ‘Z;_ =||E|2E Gombinar - % o <2 : mem’f" [ Insertar  Eliminar Format . Temss Adv
At 16 @ (= & bmu -
[[€ T o [ ET[T F [ & H [ T [ 1T [ KJ LT MTHNTJT®OGTJTPTTAa T RT[TSTTTT[TUTNVIWIIE
| omu R eff
2 oMUl 1
3 |DMu2 1
4 DMmu3 117726
5 |DMus 1,06856
6 |DMUS 1
7 |DMUs 1
8 omu? 1,01357
9 |omus 1,25406
10 |omug 1,56036
11 |oMul0 1
12 |pMull 1,25912
13 [oMu12 1
14 |omull 1,00274
15 |DMul4 1
16 |DMU1S 1
17 |DMule 1,05994
18 |oMu1? 1
19 |oMmuls 1,05749
20 |Dmuls 1,62927
21 |DMU20 1
22 |DMu21 1,1444
23 |omu22 1
24 |DMU23 1
25 DMU24 2,12814
26 _|DmU2s 12637
27 |DMU26 1
28 DMmU27 1
29 |DMu2s 1,00798
30 |oMu29 1
31 DMU30 1
3z
33
34
35
36
37
38
39
40
AR ’i efficiencies | slacks | lambdas | targets | returns | mf!mncesj+) : : : i
Wista normal D Suma=0 - o

PREEA “summary_DEA”
IR, BATKEAAERE 13 FEE Ledn, et al. (2003) 211 75 45 54 .

aviRE: 25 RIS Posibilistic fuzzy DEA model

Ledn et al.(2013)7E 25 E 4 43 M1 Y input-oriented BCC model 1% ] possibilistic 2k 2
BRI B . A AT L E R 7T LAfE deaR $2 L3RS “Leon2003”
ez,

B RRATEE— N HA:  “Summary DEA fuzzy” . N T BIUWEEER 2 BRIV
FEER, BATERATE A

data("Leon2003")

data_example <- read_data_fuzzy(Leon2003,
dmus=1,
inputs.mL = 2,
inputs.dL =3,
outputs.mL =4,
outputs.dL = 5)

20 éon, T.; Liern, V. Ruiz, J.; Sirvent, I. (2003). "A Possibilistic Programming Approach to the Assessment of
Efficiency with DEA Models", Fuzzy Sets and Systems, 139, 407-419. https://doi.org/10.1016/5S0165-
0114(02)00608-5

40
©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)



Data Envelopment Analysis with deaR \
result <- modelfuzzy_possibilistic(data_example,
h=seq(0, 1, by = 0.1),
. . — o n
orientation = "'io ’
_n n
rts = "vrs
efficiencies(result)
Z7n: h= = 0.1)4 Bi— Ao A R B2 AT Re 1 A (E P 51
AN h=seq (0, 1, by =0.1) MRS EIAE R A Be JYME P :
h=(0,0.1,0.2, .., 1)
%/, HARRREE GKF? ) FTAEHE h ) BCCinput-ori A
HATI &G, EFXIAFRRERE OKFE? ) BIHEEME h /) BCC input-oriented model X% 4;
c e Rt (B 46)
(efficiency score) i< B RTE Console itk H (WK 46) .
& — — S S\
K 46: ANE h 2R AIRCR B
ﬂ' RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help B Y = o) 84%@E Lun19nov 2:31 Vicente Q =
[ ] @ ~[Desktop/Paper_1 - RStudio
o - id + Addins ~ & Paper_L -
. [7  Environment History Connections -
Source on Save | (4 - +Run | = Source ~ = # Import Dataset - & List ~
1 library(deaR) ), Global Environment ~
2
3 fldataC"Leonzoes™) i -
4 Jdata_example <- read_data_fuzzy(Leon2003, data_example List of 9
5 dmus = 1, Leonz@e3 8 obs. of 5 variables
6 inputs.mb = result List of 10
7 inputs.dL =
8 outputs.mL = 4,
9 outputs.dL = 5)
10
11 fresult <- modelfuzzy_possibilistic(data_example,
12 h = seq(@, 1, by = 0.1),
13 orientation = "io",
14 rts = "vrs") = =
15 Jefficiencies(result) Files Plots Packages Help Viewer P o |
16 ©  NewFolder © Delets - Rename {3 More -
7| £ Home . Desktop = Paper 1 %
18 3 S
17:1 | (Top Level) 3 R Script . = Name Size) cr[rie
Console ~/Deskiop/Paper 1 e = =0 @ Rpata 8.3 K8 Nov 15, 2018, 6:20 PM
> result <- modelfuzzy_possibilistic(data_example, “ Rhistory 109K Nov17, 2018, 1:16 PM
= dlpha= 32408, 1y byi= 910, Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
+ orientation = "io",
o rte _ "yrc"y @ example_basic.R L1KB Nov 16, 2018, 12:14 PM
> efficiencies(result) 9 example_read_data.R 1198 Nov 15, 2018, 6:20 PM
@ 01 2z @3 @04 @05 06 07 @8 0.9 1 i
A 1.00020 1.00200 1.00000 1.00002 1.0000 1.00000 1.00000 1.08000 1.00000 1.00000 1.00020 @ example_read_data fuzzy.R 3160 Mov S 2018, 1 0aEn
B 1.00000 1.00000 1.00000 1.00000 ©.97674 0.94118 ©.99476 0.86747 ©.82927 0.79012 ©.75000 9 example_read_data_malmquist.R 5198 Nov 15, 2018, 11:59 AM
C 1.00000 1.00000 1.00000 1.00000 1.00000 1.00000 1.20000 1.00000 1.00000 1.00000 1.00000 % Paper_1.Rproj Sosibl NGV192 2018, 2:50°AM
D ©.75000 .73357 ©.72919 0.70809 0.68529 0.66204 .63831 B.61410 ©.58939 0.56419 ©.53846 p - :
E 0.64286 0.63977 0.63688 0.63105 0.62439 0.61719 0.60940 B.60099 ©.59189 0.58206 ©.57143 SEion 1R are Novliz0ls;1l:20/AM
F 0.60504 0.59527 0.58571 0.56507 0.54458 0.52273 0.50841 B.47761 0.45432 0.43054 ©.40625 9 session_2.R 1818 Nov 14, 2018, 4:45 PM
G 1.00080 1.00000 1.00080 1.00008 1.20000 1.00000 1.80000 1.00000 1.00000 1.00000 ©.45000 & Summary DEAR et Hov 73018 116 P
H ©.69231 0.68302 ©.68750 0.68504 0.66667 0.64000 ©.61290 0.58537 ©.55738 0.52893 ©.50000 ===
I @ summary DEA_fuzzyR || 5678 Nov 19, 2018, 2:20 AM
BAE YT B EIRINAE RS ( K 47) JF Hoa 2 A, FRATTAE A
MEEAE L HT A EARIEE RIS (W 47) JRR A ] Excel » BATAER
g

>

FFPAT AN 14

4

summary(result)
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47: possibilistic input-oriented BCC DEA model [ .45 5

File Edit Code View Plots Session Build Debug Profile Tools Window Help [ 4D = o) 83% @) Lun19nov 2:31 Vicente Q
~[Deskiop/Paper_1 - RStudio
-3 & A Go to fil - Addins - & Paper_L -
© | summary_DEA_fuzzy.R* =[]  Environment History Connections il
] [SourceonSave | O /- +Run | *= Source ~ # [ | 77 Import Dataset - | & List ~
- & Global Environment -
3 data("Leon20@3")
4 data_example <- read_data_fuzzy(lLeon20@3, Data
5 dmus = 1, © data_example List of 9
6 inputs.mL = 2, 0 Leonzeo3 8 obs. of 5 variables
g inputs.dL = 3, n s
5 outputs.nL = 4, © result List of 10
9 outputs.dL = 5)
1o
11 result <- modelfuzzy_possibilistic(data_example,
12 h = seq(@, 1, by = 0.1},
13 orientation = "io",
14 rts = “vrs") N N
15 efficiencies(result) Files Plots Packages Help \Viewer =]
@ NewFolder = © Delete = Rename | More -
/) Home - Desktop = Paper_1 3
A Name Size Modified
18:1 | (Top Level) : R Script t.
A RData 8.3 KB Nov 15, 2018, 6:20 PM
Console ~/Desktop/Paper_1/ =0
“] .Rhistory 10.9 KB Nov 17, 2018, 1:16 PM
[CI ] 1:onon,0-200016-10000 1. 0000, 810 0.0 Coll_Blasco_2006.xlsx 8.4 KB Oct 14, 2018, 2:02 PM
7 D 2.9 ©.50419 0.6583 0.0000 0.3417 @ 0 @ @ ©
77 E 0.9 9.58206 ©.3167 0.0000 0.6833 0 @ 0 0 @ 9] example_basic.R 1.1 KB Nov 16, 2018, 12:14 PM
78 F 0.3 ©.43854 0.8167 0.0000 0.1833 8 0 0 0 @ @) example_read_data.R 119 Nov 15, 2018, 6:20 PM
mG 8.9 1.00000 0.0000 0.0000 0.0000 @ @ @ 1 @
o 9
% & 4.9 0.52693 10000 0.0000 9.0000 0 @ & 0 ¢ example_read_data_fuzzy.R 317 B Nov 15, 2018, 12:03 PM
81 A 1.9 1.00000 1.0000 9.0000 0.0000 @ 0 @ @ @ @ example_read_data_malmguist.R 519 Nov 15, 2018, 11:59 AM
82 B 1.8 ©.75000 1.0000 ©.0000 0.0P00 @ O @ O @ % Paper_1.Rproj 205 B Nov 19, 2018, 2:30 AM
83 C 1.0 1.00000 0.0200 ©.0000 1.0000 @ @ @ 0 @
o :
a4 D 1.0 ©.53846 0.6667 ©.0000 0.3333 0 0 0 © © R & s e e
85 E 1.0 ©.57143 ©.3333 0.0000 0.6667 @ 0 @ 0 @ @ session_2.R 181 B Nov 14, 2018, 4:45 PM
86 F 1.0 0.40625 0.8333 0.0000 0.1667 0 0 0 0 © © summary_DEAR 6618 Now 17, 2018, 1:16 PM
87 G 1.0 ©.45000 0.0000 ©.0000 1.0000 @ @ @ @ @ o 5 DEA_f R 5678 Nov 19, 2018, 2:29 AM
88 H 1.0 ©.50000 1.0800 ©.0000 0.0000 8 0 @ 0 0 s i i
I ResultsDEA2018-11-19_02:31:36.xIsx I 8.2 KB Nov 19, 2018, 2:31 AM

Y N
N

F (2) %4 (reference set)

possibilistic model 1115, L& J& KA 7T 45 AL $5:

(1) Z4E 9% (efficiency score)

48: Excel SCAFH L 45 R

Excel Archivo Edicion Ver Insertar Formato Herranj o d _Aqda 23 [h D = o) 83% M} Lun19nov 2:32 Vicente Q =
[ XoN ) % ResultsDEA2018-11-19_02/31/36.xIsx (Sélo {ectura)l
PEHOE® XDB& 0 G- - [100% = @ )
| # Inicio | Disefio | Tablas | Grificos | SmartArt | Férmulas \ Datos | Revisar | |~
Editar 5 Fuenta Alineacidn Nimera Formeto ; Celdss. 2 Tamas
ﬁ . [#] retlenar + :[caiiori (Cuerpo) [~[11_[+]|As A [ | = abc~ | 59 Austartexo + | General |= : %ﬁ = %ﬂ = E:‘. Aad)~ g8
Pegar P uorrar v - C|lS|(HE:] (AL Combinar =% muM\ 02:‘:'\:‘::1‘:” oy " inserar Eliminar Formate | Temas  Aav
Al [ @ & (= &[ow -
e T F T ¢ T H T 1 T 1 T K T 1 [ M [ N o [ P [ o [ rR [ s [ T [ u T v [ wTI
| oMu_Nalpha cut _efficien A B C D E F G [ |
2 |A 0 1 1 a a 0 0 0 0 a
3 s 1 [ ] 0 0 [} [} 0 [
4 |c 1 a a 1 0 0 0 0 a
5 |p 075 [] 05 05 0 [} [} 0 a
6 [ 0,64286 0 01423 08571 0 0 0 0 0
7 060504 0 05714 0428 0 0 0 0 a
8 |G 1 a a o 0 0 0 1 [}
9 |H 0,69231 0 1 0 0 0 0 0 Q
10 | 1 1 a a 0 o o 0 a
dis 1 [ 3 [] 0 0 0 0 ]
H2c 1 [1] [1] 1 0 0 0 0 [1]
EEN[ 0,73957 0 05071 04929 0 [} [} 0 a
a4 e 063977 0 01571 08429 0 [} [} 0 ]
35 F 059527 0 05857 04143 0 0 0 0 a
16 |G 1 a a o 0 0 0 1 [}
a7 |u 068992 a 1 0 0 0 0 0 a
1B |A 1 1 a a 0 o o 0 a
19 le i a 1 o 0 0 0 0 Q
20 |c 1 [1] [1] 1 0 0 0 0 [1]
21 p 0,72519 0 05143 04857 0 [} [} 0 a
22 [E 0,63688 0 01714 08286 0 0 0 0 0
23 |F 0,58571 a 06 04 0 0 0 0 a
24 |6 1 ] ] 0 0 [} [} 1 ]
25 |0 06875 a 1 0 0 [ 0 0 a
26 |A 1 1 a a 0 o o 0 a
27 |8 i a 1 o 0 0 0 0 Q
28 |c 1 [1] [1] 1 0 0 0 0 [1]
29 |o 0,70803  0,6083 0 03917 0 0 0 0 0
30 [e 063105 02167 0| 07833 0 0 0 0 0
Er[ 056537 07167 o 032833 0 [} [} 0 a
326 1 [ [ 0 0 [} [} 1 ]
33 |H 0,68504 [} 1 o 0 0 o 0 a
34 |a 1 1 a a 0 o o 0 a
3508 097674 1 0 0 0 0 0 0 [
36 |c 1 [} Q 1 o o o 0 Q
27 In 0 g g g 0
[
£

“Summary_DEA_fuzzy” .
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7.6. BIFRZ5 R plot() K%
iz F plot() & %, F AW PLFE conventional DEA model . Malmquist 4= 7= 77 48 %
(Malmaquist index) B} cross-efficiency model 3815 — st B AT AL R . - 14, 7R
%1 15 FosB] 16 H4 53 50T HEBEAT R B
plot() ERECREC LA R 77 2z 17
plot(x)

EXH, x f21#%1F T DEA model BT 7145 B AN .
IZAT plot()RE)E, ATKAE Viewer Fr2EF A NE D) RMGLELE R, AT LLIE
T Viewer (] Export BIFRRRAFZE, B EKTTLLZE “png” « “jpeg” BLH#H
“tiff? o WAL AL R HI B RGN, IR E RS2 word SCRYH .

deaR [ 4 Al i A4S B 1 1 R F2 4t fuzzy DEA models & 5& .

HETRATIEAESU T 20t deaR HHIEIRGE R, AT E S/ N —MRAHd.

ENZEL: #: Basic DEA model
TP A “ Summary_DEA” . TR &L KM 7 TAEwEE N, RATFEZITIFBH
“Paper_1” , JN#X deaR, #AJ5 T IFHIA .

FATH TAE 215 & DN % WA 49 Pk

49: JHIA “Summary_DEA”

I' RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ 0

= o) 57% @) Dom25nov 19:24 Vicente Q =

[ ] [ ] ~[/Desktop/Paper_1 - RStudio
o - X 2 - - Addins - % Paper_1 — Desktop -
© | Summary_DEA.R = [7]  Environment History Connections i)
Source on Save R +Run | *=+ Source o “ Import Dataset ~ & List ~
1 library(deaR) "} Global Environment ~
2
3 # STEP 1. LOADING DATA:
; data("Hua_Bian_2007") Environment is empty
6 # STEP 2: ADAPTING THE DATA:
7 data_example_12 <- read_data(Hua_Bian_2007,
8 ni=2,
9 no=3,
10 ud_output=3)
11
12 # STEP 3: RUNNING THE DEA MODEL:
13 result_example_12 <- model_basic(data_example_12, Files | Plots Packages Help Viewer -
14 orientation="o0" -
15 rts="vrs", ©  New Folder © Delete = Rename {F More -
16 vtrans_o= 1508) £ Home - Desktop = Paper_1 ¥ .
17 A Name size Modified
18 # STEP 4. EXTRACTING (PARTIAL) RESULTS: t
19 eff <- efficiencies(result_example_12) o
@ .RData 8.3 KB Nov 15, 2018, 6:20 PM
20 eff
21 1/eff  # reuslt M5 in table -5 (p. 119) | .Rhistory 11.2 KB Nov 19, 2018, 3:07 AM
2z
23 # SUMMARY OF RESULTS Coll_Blasco_2006.xlIsx 8.4 KB Oct 14, 2018, 2:02 PM
24 @ example_basic.R L.1KB Nov 16, 2018, 12:14 PM
25 summary(result_example_12) @ example_read_data.R 1198 Nov 15, 2018, 6:20 PM
26
I @) example_read_data_fuzzy.R 3178 Nov 15, 2018, 12:03 PM
26:1 | (Top Level) = R Script @ example_read_data_malmquist.R 5198 Nov 15, 2018, 11:59 AM
Console ~/C =0 K Paper_l.Rproj 205 B Nov 25, 2018, 7:23 PM
o 'help.start()' para abrir el sistema de ayuda HTML con su navegador. 9 session_LR 478 Nov 1, 2018, 11:26 AM
Escriba 'q()' para salir de R. @ session_2.R 1818 Nov 14, 2018, 4:45 PM
@) Summary_DEA.R 6618 Nov 17, 2018, 1:16 PM
[Workspace loaded from ~/Desktop/Paper_l/.RData]
@) summary_DEA_fuzzy.R 5758 Nov 19, 2018, 3.07 AM

>

WP 50 A, FATIEFEE 117 library(deaR) £ 5 16 17, RGBTk e 4. 53
FIZE R 2 3 M RBFIN T Environment 2, EA 1552 “data_example_12”7
“ Hua_Bian_2007” H1 “result_example_12” .
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50: PATHIA AR 4

" RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ {l) 2 W) 57% @) Dom25nov 19:24 Vicente Q i=
[ ] @ ~[Desktop/Paper_1 - RStudio
o .| o |- -+ Addins ~ & Paper_1 — Desktop -
@ | Summary_DEAR —["]  Environment History Connections =
Sourceon Save O /- +Run | = Source - T # Import Dataset ~ | & List =

1 library(deaR) 7} Global Environment =

2

3 # STEP 1. LOADING DATA: 4

4 data( "Hua_Bian_280@7") ) data_example_12 List of 9

5 ? Hua_Bian_2007 3@ obs. of 6 variables

6 # STEP 2: ADAPTING THE DATA: O result_example_12 List of 11

7 data_example_12 <- read_dataCHua_Bian_z@@7,

8 ni=2,

9 no=3,

10 ud_output=3)

11

12 # STEP 3: RUNNING THE DEA MODEL:

13 result_example_12 <- modeLbnsic(data,t_axmplg,lz, Files POl e -0

14 orientation="00", - =

15 rts="vrs", @ NewFolder | @ Delete = Rename { More ~

16 vtrans_o= 150@) #2) Home - Desktop  Paper_l L |

17 A Name Size Modified

18 # STEP 4. EXTRACTING (PARTIAL) RESULTS: +

19 eff <- efficiencies(result_example_12) =

20 off @) RDara 8.3 KB Nov 15, 2018, 6:20 PM

20 1/eff # reuslt M5 in table 6-5 (p. 119) .Rhistory 11.2 kB Nov 19, 2018, 3.07 AM

22 }

23 # SUMMARY OF RESULTS Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM

z4 9] example_basic.R 1.1KB Nov 16, 2018, 12:14 PM

25  summary(result_example_12) @ example_read_data.R 1198 Nov 15, 2018, 6:20 PM

26

@ example_read_data_fuzzy.R 3178 Nov 15, 2018, 12:03 PM

1l (Top Level) + R Script = @ example_read_data_malmguist.R 5198 Nov 15, 2018, 11:59 AM
Console ~/Desktop/Paper_1/ =0 &' Paper_l.Rproj 2058 Nov 25, 2018, 7:23 PM
> # STEP 3: RUNNING THE DEA MODEL: @1 session_LR s Beow X, 2028.1.1.20 AM
> result_example_12 <- model_basic(data_example_12, 9 session_2.R 1818 Nov 14, 2018, 4:45 PM
i ::;E[‘:‘::}"":‘ 997, O Summary_DEAR 6618 Nov 17, 2018, 1:16 PM
+ = ,
5 vtrans_o= 1500) @] summary_DEA_fuzzy R 5758 Nov 19, 2018, 3:07 AM
>

DEA model {145 R4l 7> Bogs

(EHAELEAE) T X5 “result_example_127 . N1 %4

Horp—se 25 B, RATERA RIS 27 175 T HBIT LT R4
plot(result_example_12)
Z J& Console THIMR 2= o~ M5 B

Press [enter] to continue

%R Enter 5, 1E Viewer #3% (A NE 1) FTERATFESERWNE 51 s —NEE.

51: 12 2K 1

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help G 40 = o) 48% @) Lun26nov 16:57 Vicente Q
[ ] [ ] ~/Deskiop/Paper_1 - RStudio
e - R ™~ - Addins - % Paper_1 — Desktop -
@ | plot_example_12.R =1 Environment  History  Connections (=]
Source on Save | 4 - #Run | >=% Source ~ - ~ Import Dataset = | § List ~
fl’ i “h Global Environment -
12 # STEP 3: RUNNING THE DEA MODEL: Data
13 result_example_12 <- model_basic(data_example_1Z 0 data_example_12  List of 9
" orisntation="00", © Hua_Bian_2067 30 obs. of 6 variables
a5 rts="vrs", S 1 Te 12 Li £ 11
16 vtrans_o= 1500) ) result_example_. ist o
17 Values
18 # STEP 4. EXTRACTING (PARTIAL) RESULTS: eff Named num [1:30] 1 1 1.18 1.87 1 ...
19 eff <- efficiencies(result_example_12)
20 eff
Z1 1/eff # reuslt M5 in table 6-5 (p. 119)
2z
23 # SUMMARY OF RESULTS Ll Blaglt8 o GO =0
24 = Export + | @ ' <% Publish =
25 summary(result_example_12) = iy i ehGse
i Efficient/Non Efficient DMUs Non-efficient DMU distributio
T
R Script ¢
cript 5
15 14
=0
7 ©.0000 ©.0000 ©.0000 ©.9578
S ©.0000 ©.0000 ©.0000 ©.0696 4
9 8.8455 ©.0000 ©.0000 ©.0000 10
10 ©.0000 ©.0000 ©.0000 ©.0000 € €
1 2.0000 .0000 ©.0000 8.0722 é é
12 ©.8000 0.0000 0.0000 ©.0080
13 ©9.2558 0. 0000 0.0000 ©.0000 2
14 ©.0002 0. 0000 0.0000 ©.0000 5
15 ©.0002 0. 0000 0.0000 ©.0000
16 ©.0000 ©.0000 ©.0000 ©.0000
17 ©.0000 ©.2000 ©.0000 ©.0000
[ reached getOption("max.print") -- omitted 13 rows ] 2 5
> plot(result_example_12) Non-efficient Efficient 12 15 18 21

Press [enter] to continue

Efﬂ.ciency
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Kl 1 8 THZ DMU (efficient) FIERL DMU Cinefficient) H%&E CHED , LG
BRI HL (efficiency score) MR (EED o WRBANTEE Zoom 4, KIE

A LABTECR (ZWE 52) .

52: ERBOK

@ RStudio File Edit Code View Plots Session Build

Debug Profile Tools

Window Help

G O 2 o) s50%M@D Lun26nov 16:52 Vicente Q

o -logRIRIS
Efficient/Non Efficient DMUs

0 graficos_

® N c
g
o

2
1o
11
iz # B
13  res|
14
15
16
17
18 # P 10
19 eff
20 eff
21 179
2e
23
24
25 sumn
26
27 plo
28 5
29
30
che
281 (T

3
2=
Count

Console ~

14
15
16
17 0

[ reached

ot Zoom

Non-efficient DMU distribution

-

Count

0

1 Paper_1 — Desktop ~

=0

List ~

=0

“E- Publish ~

cient DMU distribution

> plot(res Non-efficient

Press [ent

Efficient

18

15

21 15
Efficiency

Effic iency

g Enter B, B2 ERE ANEER. ZNERMBATFZER EMU (efficient) #7f
FEHHERL DMU Cinefficient) %4 (reference set) HIREL.

K 53: sl 12 2 F 2

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help G YO = o) 48%M@) Lun26nov 16:57 Vicente Q =
~fDesktop/Paper_1 - RStudio
. 5 -~ Addins - & Paper_1 — Desktop -
@ plot_example_12.R [  Environment History Connections ]
SourceonSave | (4 +Run | =+ Source ~ 2 “ Import Dataset ~ & List ~
i’ bs il 7k Global Envirenment =
12 # STEP 3: RUNNING THE DEA MODEL: Data
13  result_example_12 <- model_basic(data_example_12, 0 data_example_12 List of 9
i orientation="ans, ©OHua_Bian_2007 30 obs. of 6 variables
15 rts="vrs", = 8
16 vtrans_o- 1508) O result_example_12 List of 11
17 Values
18 # STEP 4. EXTRACTING (PARTIAL) RESULTS: eff Named num [1:38] 1 1 1.18 1.87 1 ...
19  eff <- efficiencies(result_example_12)
20 eff
21 1/eff  # reuslt M5 in table 6-5 (p. 119)
22
23 # SUMMARY OF RESULTS EResl Fiots e =0
24 # Zoom | X Export ~ % Publish ~
25 summary(result_example_12) -
2 ovuzo|  [—— 1
27 plot(result_example_12) omuzed [ NN ©
27:24  (Toplevel) : R Script ¢ omuzz{ [ N -
—m| owuzs) [
B - owuzs{ I 5
) 0.0000 ©.0000 ©.0000 2.2696 =
oMU22 2
9 0.0455 ©.0000 ©.0000 2.0000 = —— -_1
10 0.0000 ©0.0000 ©0.0000 0.0000 =
1 0.0000 0.0000 0.0000 0.0722 oM
12 ©.0000 0.0000 ©0.8000 0.0000 I
13 .2558 0000 2.0000 0.0000 Somuei
14 0.0000 ©.0000 ©.0000 0.0000 W pmutz
15 ©.0000 ©0.0000 ©.0000 0.0000 DMU1D
16 0. 0000 0.0000 0.0000 0.0000 DMUG -
17 0.0000 ©.0000 ©.0000 0.0000 DMUS ‘O
[ reached getOption("max.print") -- omitted 13 rows ] 2
2 omuz{ |o
> plot(result_example_12) DMU1 }0
Press [enter] to continue 0 3 6 9

Press [enter] to contmuel

# times appearing in reference sets
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e, FHRI% Enter B, FATAT LR BIf)E —MER (Z0E 54)

54: 12 2 3

ﬂ' RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help B <O = W) 48%@} Lun26nov 16:57 Vicente Q =
e0e Plot Zoom |
o -logld # Paper_L — Deskiop -
@] plot_ex: =0
n"] List
19
il |
1z # 5§ |
13 resu]
Dii10
14
e pAiDI2 s
16
17 DiD14 Dfs
18 # STI | EET
19 effl
i@ @7
20 eff s 3 Dl 4
21 1/ef] s D@9 D@2
2z D@3 |
23 # sul Dl’“ ® [ =0
24 | < Publish =
25 summ( DI.l? D.‘.H D.’E& D..‘I |
e ®
27 plot D] 25
oy DND16 74 a
D0 DN 8 Dy@24 A0
comoe -1 0 0 E
9 DMUS
10
5t D22 : D9 i; U2
12
.z 2HNu |
13 DI 3 DNg27 A
14 [.ﬁ 25
24PMDI30

15
16
17
[ reached

DMVmI29
127

>
> plot(resy
Press [ente
Press [ente
>

fEKE 54, FATATDLE AW, st EIGERA % oMU, 20t AR
R DMU. XA R 1R DMU SE 4 543 %% DMU ARSI, I Hisk B A% 1k
FEAT R DMU R T RCRIL T

WEFENZ, JFEmAE RS B MR .. EXFELR T, [BHIERKN S EE
5 % DMU X T2k DMU 54 2 S E E 1A,

Bz AR EE N “plot_example 127

v EE: 22 K&: Malmquist index

o, Bl —ASHA a2 A “plot_malmgquist” . TR LR T TESURE
O, ATFEEITHTE “Paper 17, NEX deaR, RGO
Hk, iZ1T Malmquist index. AItt, FRAERATE N
data("EconomyLong")
data_example_15 <- read_malmquist(EconomylLong,
percol = 2,
arrangement = "vertical",
inputs = 3:4,
outputs = 5)

result_malmquist <- malmquist_index(data_example_15,
orientation = "io")

46
©Coll-Serrano, V.; Benitez, R. and Bolds, V. J. (2018)



Data Envelopment Analysis with deaR dR

Note: The data are in long format.

PATHES (WK 52) .

55: iz{T Malmquist index

#@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [y <0 = o)) 55% @)} Dom 25nov 19:28 Vicente Q =
@ [ ] ~[Desktop/Paper_1 - RStudio
o - oy * - - Addins - K paper_1 — Desktop -
@ | plot_example_12.R —["]  Environment History Connections =0
o +Run | "= Source = o ~ Import Dataset ~ | & List +
1 patac EconomyLong") %% Global Environment -
2 data_example_15 <- read_malmquist(EconomyLong,
Data
3 percol = 2, :
4 arrangement = “vertical®, dataexample 12 Listof 2
5 inputs = 3:4, data_example_15 List of 5
6 . . outputs = 5) EconomyLong 155 obs. of 5 variables
7 result_malmquist <- ma'Lmqu1st,lndex(das:a,exa@ple,l%r ) Hua. Bian. 2007 30 obs. of 6 variables
8 orientation = "io")
9 result_example_12 List of 11
10 I result_malmquist List of 14 I
Files Plots Packages Help Viewer =0
@ NewFolder | @ Delete < Rename {JF More ~
#Y Home - Deskiop = Paper_l E
A Name size Modified
@) RData 8.3 KB Nov 15, 2018, 6:20 PM
L1 (Top Level) * R Script =
1 .Rhistory 11.2 KB Nov 19, 2018, 3.07 AM
Gansale s iDeakn p/Eapsr T =0 Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
>
> # STEP 3: RUNNING THE DEA MODEL: 91 example_basic.R 1.1K8 Nov 16, 2018, 12:14 PM
> result_example_12 <- model_basic(data_example_12, @] example_read_data.R 1198 Nov 15, 2018, 6:20 PM
A RELRI L s 9 example_read_data_fuzzy.R 3178 Nov 15, 2018, 12:03 PM
+ rts="vrs",
+ vtrans_o= 1580) @] example_read_data_malmguist.R 5198 Nov 15, 2018, 11:59 AM
> data("EconomyLong™) % Ppaper_l1.Rproj 2058 Nov 25, 2018, 7:23 PM
data_example_15 <- read_malmguist(EconomylLong,
e o -malmquistC biom) 9 session_L.R 478 Nov 1, 2018, 11:26 AM
+ percol = 2,
+ arrangement = “vertical”, @7 session_2.R 1818 Nov 14, 2018, 4:45 PM
+ inputs = 3:4, © Summary_DEA.R 6618 Nov 17, 2018, 1:16 PM
+ outputs = 5) o f :
> result_malmquist <- malmquist_index(data_example_15, Siznmary DEA- fuzzy:R S75R Nov'19, 2018, 3:07/AM
+ orientation = "io") 9 plot_example_12.R 6858 Nov 25, 2018, 7:26 PM
>

I 97 plot_malmquist.R I 4038 Nov 25, 2018, 2:20 PM

Malmquist index 45 5B ARALEXT B “result_malmquist” 4. B FR, FRATLER
AHBHANFFHPATUL TS, LR K4S
plot(result_malmquist)

and run the instruction. The following message will be displayed in the Console:

Press [enter] to continue

1% Enter ##)5, R EI/RIE Viewer b5 (A REH) (WK 53) o FATAT LR
i Zoom IZ 4 IhRe kit — P EBEE . F—EHEH 7R DMU 7EREE IR BN 1)
Malmaquist index M ARG 7. WREER S DMU 8 K2 LLE T2 | 2R,
PRA] DA AR SIER DMU BTSSR (MR AREH ) DMU K 7EEERHH
K)o
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56: Malmquist index 2 & 1

ﬂ' RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help [ {D 2 W) 54% @) Dom25nov 19:30 Vicente Q =
[ NoN ) ~[Desktop/Paper_1 - RStudio
o -yl - - « Addins - % Paper_l — Desktop *
© | plot_example_12.R ©] plot_malmquist.R* = [7]  Environment History Connections ]
Source on Save | O - +Run | "= Source v | = - # Import Dataset = | & List ~
1 dataC"EconomylLong") 7} Global Environment +
2 data_example_15 <- read_malmquist(EconomylLong,
Data
3 percol = 2, - s
4 arrangement - “vertical®, ) data_example_12 List of 9
5 inputs = 3:4, © data_example_15 List of 5
6 e TICPULE = )  EconomylLong 155 obs. of 5 variables
7 result_malmquist <- ma'Lmqu1st_mdex(data_exar}uple_l%. ) © Hua_Bian_2007 30 obs. of 6 variables
8 orientation = "io") =
9 D result_example_12 List of 11
1@ plotCresult_malmquist) © result_malmquist List of 14
11
Files Plots Packages Help ‘v wer ’ =]
| ¥ Zoom  -X Export + |ﬁ_ r's “% Publish -
L2
o
B ra v |
z . = : = -- -
= e T e —— Beiling
Console ~/Desktop/Paper_1/ =0 E ~ —— Chongging
> result_example_1Z <- model_basic(data_example_1Z, = . Fujian
+ orientation="o0c", g g EF&E —— Gansu
+ rts="vrs", Guangdong
+ vtrans_o= 158@) e :
Guangxi
> data("EconomyLong™) o e
> data_example_15 <- read_malmquist(Economylong, “? oy
+ percol = 2, = Hainan
+ arrangement = “vertical”, ] Hebel
+ inputs = 3:4, K] ~— Helilongjiang
+ outputs = 5) g 1.2 Henan
> result_malmquist <- malmquist_index(data_example_15, 5 14 =— = ——— Hubei
e - orientation = "io") = 1 —— Hunan
> plot(result_malmguist) © 2006 2007 2008 2009
Press [enter] to continue = B
Press [enter] to continue Period
LUK Enter 4, H9E P
izn éiiiéé*: é( l?”tf?r jg;, 4\ 3#34—_A <] o
57: Malmquist index 2 [&] 2
® RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help B 4O = o) 54% @} Dom25nov 19:30 Vicente Q =
ece ~/Desktop/Paper_1 - RStudio
e - R - - $ C - Addins - % Paper_1 — Desktop -
@ | plot_example_12.R @ | plot_malmauist.R* —[71  Environment History Connections ==
SourceonSave = 4, 4 - +Run | %+ | #Source v | = o # |mport Dataset + | & List +
1 data("Economylong") 7k Clobal Environment -
2 data_example_15 <- read_malmquist(EconomylLong,
Data
3 percol = 2, 5 :
4 arrangement = "vertical®, U data_example 12  List of 9
5 inputs = 3:4, O data_example_15 List of 5
6 ) ) outputs = 5) © EconomyLong 155 obs. of 5 variables
7 result_malmguist <- mulmqu1st,lndex(data,exumple,lé, ; O Hua_Bian_2007 30 obs. of 6 variables
8 orientation = "ic") =
g © result_example_12 List of 11
10 plot(result_malmguist) O result_malmquist List of 14
11
Files Plots Packages Help { Viewer =1
| = # Zoom | -Z Export -| Q <5 Publish =
11:1  (Top Level) 3 R Script = % ~— Efficiency change
opleve) © gt 2 N Malmgquist index
Console ~/Desktop/Paper_1/ =0 ~— Productivity change
+ orientation="o00", \_ Scale change
+ rts="vrs", g \ Technical change
+ vtrans_o= 1508) \
> data( "Economylong”) g
> data_example_15 <- read_malmquist(Economylong, ©
+ percol = 2, 2
+ arrangement "vertical”,
+ inputs = 3:4,
+ outputs = 5)
> result_malmquist <- malmquist_index(data_example_15,

£ orientation =
> plot(result_malmguist)
Press [enter] to continue
Press [enter] to continue

“i0")

2007

2008

Period

R TR e A BN Malmquist index Az 2 EGER 2 1 U T2 % (geometric
mean) . FATATLLS T Zoom SRBUKKEIZR, Wrl bl bdarkikEl (BiaTdt) kitiTH#
YE. ZEIER] DL B € 1) Malmaquist index DL 7R H 22 5] 2044

RE “plot_malmaquist” .
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aiRE: 2 Cross efficiency

B, IS RIA IR Ay &N “plot_cross_efficiency” - WHR LM T TS
WE L, WAVFEFTIBHE “Paper_17 , hN#k deaR, SR/EHIEHIA
ENFPATUL T RS (S WE 55) -
data("Golany_Roll_1989")
data_example <- read_data(datadea = Golany_Roll_1989,
dmus=1,
inputs = 2:4,
outputs = 5:6)
result_cross <- cross_efficiency(data_example,
orientation = "io",

rts = "crs",
selfapp = TRUE)

58: Malmquist index 2 |8 3

@ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help B +O 2 o) 53% @) Dom25nov 19:32 Vicente Q =
[ NN ) ~(Desktop/Paper_1 - RStudio
e - g i - Addins - & Paper_l — Desktop -
& plot_example_12.R T e [~ Environment History Connections (=]
Source on Save | 4/ - +Run | v+ Source ~ r # Import Dataset ~ & List -
1 hﬂta("Gulany,RolLlBBB“) "} Global Envirenment -
2 data_example <- read_data(datadea = Golany_Roll_1989, =
3 dmus = 1,
4 inputs = 2:4, data_example List of 9
5 outputs = 5:8) data_example_12 List of 9
6 result_cross <- cross_efficiency(data_example, data_example_15 List of 5
it ur\ent?tlu:l =0 EconomyLong 155 obs. of 5 variables
8 rts = "crs”, I_my m— =
9 selfapp - TRUE) Gulany,RulleSQ 1_3 obs. of & vumablesl
1@ Hua_Bian_Z@@7 3@ obs. of 6 variables
I result_cross List of 13 I
Files Plots Packages Help Viewer =0
O NewFolder | @ Delete - Rename {JF More -
/2 Home - Desktop  Paper_1 B .
A Name Size Modified
] .Rhistory 11.2 KB Nov 19, 2018, 3:07 AM
Ll | (Top Level) * R Script =
Coll_Blasco_2006.xIsx 8.4 KB Oct 14, 2018, 2:02 PM
consolaie [Duskinp Bapar 1 =0 @ example_basic.R L.1KB Nov 16, 2018, 12:14 PM
> result_malmquist <- malmquist_ingex(data_example_15,
s orientation = "io") @ example_read_data.R 1198 Nov 15, 2018, 6:20 PM
> plot(result_malmquist) @ example_read_data_fuzzy.R 3178 Nov 15, 2018, 12:03 PM
Press [enter] to continue @ example_read_data_malmquist.R 5198 Nov 15, 2018, 11:59 AM
Press [enter] to continue
> data("Golany_Roll_1989") & Paper_l.Rproj 205 B Nov 25, 2018, 7:23 PM
> data_example <- read_data(datadea = Golany_Roll_1989, @ session_1.R 47B Nov 1, 2018, 11:26 AM
= e @ session_2.R 181 B Nov 14, 2018, 4:45 PM
+ inputs = 2:4,
+ outputs = 5:6) @] Summary_DEA.R 661 B Nov 17, 2018, 1:16 PM
> result_cross <- cross_efficiency(data_example, @ summary_DEA_fuzzy.R 575 B Nov 19, 2018, 3:07 AM
Iy orientation = ilon e I le_12.R 685 B Nov 25, 2018, 7:26 PM
L rts = "crs”, plot_example_12. ov 25, :
+ selfapp = TRUE) 9 plot_malmquist.R 403 B Nov 25, 2018, 2:20 PM
= 1 @ plot_cross_efficiency.R | 416 B Nov 25, 2018, 7:19 PM

A LLE R, FEXT B “result_cross” HARAE T 38 X RUHE (cross efficiency) )45 R .
arbitrary. benevolent Fll aggressive. P iXst Bn] DLBIEAE A plot() bR Hwt 21 Bl —
MEASE . Nk, FATERAFT SN

plot(result_cross)

fE£ Console THIHR 4% Enter $LLR R ANFIIEIR . SRAFAIL R M U1E 56 PR
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50. 48 UMK

.‘ RStudio File Edit Code View Plots Session Build Debug Profile Tools Window Help & ‘@ = o)) 53% @) Dom25nov 19:32 Vicente Q =
0@ ~[Desktop/Paper_1 - RStudio
O -0l H B A Go to file/f Addins = % paper_1 — Desktop -

@ plot_malmquist.R*

Q /-

O plot_example_12.R

# =
data("Golany_Roll_1983")
data_example <- read_data(datadea

dmus
inputs B
outputs :6)
result_cross <- cross_efficiency(data_example,
orientation = "io",
rts “ors”,
selfapp = TRUE)

|| source on Save

1,

Golany_Ro11_1989,

plot(result_cross)

11:1 | (Top Level) =
Console ~/Desktop/Paper_1/
> plot(result_malmquist)
Press [enter] to continue
Press [enter] te continue
> data("Golany_Roll_1989")
> data_example <- read_data(datadea
dmus =
inputs = Z:4,
outputs = 5:6)
result_cross <- cross_efficiency(data_example,
orientation = "io",
rts = "crs”,
selfapp = TRUE)

Golany_Rol1_1989,

1,

> plot(result_cross)
Press [enter] for next plot
Press [enter] for next plot

= Run

=0

e d + Source ~

R Script *

=0

Environment  History
B
& Global Environment =

Data

@ data_example

© data_example_12

© data_example_15

© EconomyLong

© Golany_Rol1_1989

© Hua_Bian_zee?

© result_cross

Plots  Packages

/2 zoom

Files

~* Import Dataset ~

=0

List ~

Connections

'

List of 9

List of 9

List of 5

155 obs. of 5 variables
13 obs. of & variables
3@ obs. of & variables
List of 13

=0

% Publish -

Help

Export

WA
Ma |
WA

Arbitrary Method

WA
WG ]
WA |
WA -
WA -
WA -

g
=]
=
=

WA -
WA ]
WA ]

REEBIAS R “plot_cross_efficiency” , <PTH H IFiB i RStudio.
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